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People Suite Tools 
The ACS People Suite offers several tools to help you accomplish your church or organization's goals. 

To learn more about a page, see the links below.  

Background Checks 
In today's world, it's important to know exactly who is volunteering, serving, working, and caring for your 

church or school family. That's why we've partnered with Verified First to bring you comprehensive, 

detailed, and convenient background checks. 

Background Checks features include: 

• A secure online application. Protect applicants by allowing them to enter their personally identifiable 

information at their convenience. You can launch email invitations straight from the product and reports 

sync back to individual profiles. 

• Additional controls over staff rights. Choose who can submit background checks, view results, or do both. 

• Pay one bill, not two. We’ve consolidated billing, so you’ll receive just one statement from ACS 

Technologies. Use the Reference Code field inside Verified First to enter a ministry area's GL code, so you 

know where to apply charges when you receive your bill. 

• Comprehensive results. Verified First offers several background check packages to fit your church's needs. All 

packages include a Nationwide Criminal Search and Social Security Number trace. 

Getting Started 
Before processing background checks, you'll need to update your ACS or HeadMaster software to the 

latest version and sign up for eBilling. 

If you're new to background checks within ACS, you must sign up for a VerifiedFirst account. Your church 

only needs one Verified First account- every staff member who requests or reviews background checks 

use this account. 

1. Log into ACS People Suite as an administrator. 
2. Under Manage Records, click the People tab.  
3. In the drop-down list, select View/Edit Individual and click Go . 
4. Select the individual whose background check you are requesting and click View/Edit.  
5. On the Safeguard tab, click Request Background Check. 
6. Complete and submit the online agreement for service to Verified First. 

Verified First will contact you to review it and process the agreement, and they will send you an email 

update when finished. 

After Verified First processes your agreement, you can click Request Background Check to access 

the background check application at any time. 

Setting up Background Check Permissions 
Background check results contain sensitive information, so you may want to restrict staff members' 

rights. 

https://wiki.acstechnologies.com/display/ACSDOC/People+Suite
https://www.acstechnologies.com/products/acs/features/acs-background-checks
https://www.acstechnologies.com/screening#packages
https://clientdownloads.acstechnologies.com/Account/LogOn?ReturnUrl=%2fhome%2findex%3fbrand%3dACS&brand=ACS
https://clientdownloads.acstechnologies.com/Account/LogOn?ReturnUrl=%2fhome%2findex%3fbrand%3dHeadMaster&brand=HeadMaster
https://portal.acstechnologies.com/acs/my-account/automatic-payments
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Only staff members with proper access can view the Safeguard tab, request background checks, review 

background checks, or view comments associated with background checks. You can edit security levels 

in Add/Edit Users. 

About granting and restricting permissions 

You must give new users with All rights access to Verified First to order background checks and 
view reports. If you remove a user's rights in ACS People Suite, you must also remove them in 
Verified First. 

If you restrict an individual from requesting or reviewing background checks but do not restrict his 
rights to the other options, the individual can still view any notes about results that are entered in 
Safeguard Comments or Safeguard Tasks. 

To Edit a Staff Member's Safeguard Access: 

1. Under Advanced Tools, click the Admin Utilities tab. 
2. In the drop-down list, select Add/Edit Users and click Go. 
3. Select the user whose security you want to change and click Edit. 
4. Click the Security tab. 
5. Expand People, then scroll to Safeguard Background Checks, Safeguard Comments, Safeguard 

Tasks, and Safeguard Tasks Mass Create and Update. 
To grant an individual full rights to all background check features within ACS, select All for all Safeguard permissions.  
To restrict an individual from requesting or reviewing background checks in Verified First, but grant rights to view the 

Safeguard tab and any comments and tasks, select None for Safeguard Background Checks, and All or View for 

Safeguard Comments, Safeguard Tasks, and Safeguard Tasks Mass Create and Update. 
To restrict an individual from the Safeguard tab, including requesting and reviewing background checks as 

well as comments and tasks, select None for all Safeguard permissions. 
6. When you're finished, click OK. 
 

Tracking Background Check Processes and Results with 

Safeguard Tasks 
Safeguard Tasks let you manually track your background check process and results.  

Tasks consist of Task Descriptions and Task Statuses. 

Task Descriptions describe tasks you're tracking related to background checks. For example: Signed 

Consent Form, Drive Church Vehicle, and Work with Children might be task descriptions.  
Task Statuses describe the results. For example, Yes, No, Pending, and Restrictions Apply could be 
task statuses. 

You can enter comments for each task, which is helpful if you want to enter notes related to background 

checks or their results. You can also track dates on tasks, which is helpful if you want to track when a 

background check was completed so you'll know when to request a new one 

https://wiki.acstechnologies.com/display/ACSDOC/Add+Edit+Users+-+Security
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Set up task permissions 
Before setting up Safeguard tasks, set up Safeguard permissions in Add/Edit Users.  

Task permissions are especially important if you choose to enter sensitive information in Safeguard tasks 
and comments. If you restrict an individual from requesting or reviewing background checks but do not 
restrict his rights to the other options, the individual can still view any comments and tasks that may 
contain information about results. 

Set up task descriptions and statuses 
In Define Lists, you can set up Task Descriptions and Task Statuses based on your background check 

processes and results. 

1. Under Advanced Tools, click the Define Lists tab. 
2. In the drop-down list, select People, then click Go . 
3. In the Define Lists window, expand Safeguard, then click Task Description or Task Status. 
4. To add tasks, click Add.  
5. Enter a task in the Field Description field.  
6. Optional: Select Add Another to add several items at one time. 
7. Click OK. 
8. To edit a task, select it and click Edit.  
9. Make the necessary changes and click OK. 

After setting up Safeguard task permissions, descriptions, and statuses, you can add tasks to individual 

records or multiple individuals' records
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Adding and Updating an Individual's Safeguard Tasks 
Once you've set up Safeguard tasks, you can add tasks to individual records. 

On the individual's Safeguard tab, you can add new Safeguard tasks and edit existing ones. For 

example, if an individual returns a signed consent form, you can update the individual's record to 

reflect that is was returned and include the date. You can review tasks and the comments associated 

with them at any time.  

You can also edit or delete a task from an individual's record. Don't worry- you can still always click 

Review Background Checks to view the background check results. 

1. Under Manage Records, click the People tab. 
2. In the drop-down list, select View/Edit Individual and click Go.  
3. Select the person's record and click View/Edit.  
4. On the Safeguard tab, click Add.  
5. In the Description drop-down list, select a description for the task. 
6. In the Status drop-down list, select a status for the task. 
7. If the task is complete, enter the date the task was completed. If the task has not been completed, 

do not select a date; you can enter a completion date at a later time. 
8. If you want to enter a comment for the task, do so in the Comment field. 
9. To add another task for this individual, select Add Another. 
10. Click OK. 

Print Tasks 
You can print the Safeguard Tasks grid for an individual's record as it displays in the View/Edit 

Individual window. 

1. Under Manage Records, click the People tab. 
2. In the drop-down list, select View/Edit Individual and click Go  . 
3. Select the individual whose Safeguard tasks you want to print and click View/Edit. 
4. Click the Safeguard tab, then click Print. 
5. A report containing the individual's Safeguard tasks will appear. To print the report, click Print. 

You can also print the Listing of Safeguard Tasks. This report is a list of individuals with their 

Safeguard tasks and comments, name, address, and phone number. 

 
Adding and Updating Safeguard Tasks for Multiple Individuals 

You can create several tasks at once for individuals based on search results. 

Suppose you created a task called Signed Consent Form to track when an individual consent to a 

background check. You can search on all staff members who do not have a Safeguard task entered 

for Signed Consent Form, then create a task for all of them. 

When you mass create the tasks, you can select the description, status, and enter a comment. 

1. Under Searches and Reports, click Searches. 
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2. Select the appropriate options from the Search Information and Search Criteria tabs to perform 

your search. 
3. Click Process on the Search Criteria tab to process the search. 
4. Click OK. 
5. On the Results tab, right click within the window and select Create Safeguard Tasks. 
6. Select the Description. 
7. Optional: Select the Status, Date Completed, and enter a Comment. 
8. Click OK. 
9. A confirmation message displays. Click Yes to continue. 

You can update several tasks at one time based on search results. You can change the task 

description, status, or both, and you can also insert or replace the comments on your Safeguard tasks. 

From the example above, suppose you've received signed consent forms from the individuals. You can 

update the Signed Consent Form task to display a result of Complete. 

We highly recommend making a backup before processing a mass change of your Safeguard tasks. 

1. Under Searches and Reports, click Searches. 
2. Select the appropriate options from the Search Information and Search Criteria tabs to perform 

your search. 
3. Click Process on the Search Criteria tab to process the search. 
4. Click OK. 
5. On the Results tab, right click within the window and select Update Safeguard Tasks. 
6. Under Safeguard Task Before, select the Description and Status. If you want to select a 

specific completed date, clear the All Dates checkbox and select or enter a date in the Date 
Completed field. 

7. Under Safeguard Task After, select the Description and Status that the tasks will be changed 

to. If you want to change the completed date, clear the Retain Value checkbox and select or 

enter a date in the Date Completed field. 
8. In the Comment box, enter the comment you want to insert for these tasks. Select Insert 

Comment to add the comment, or Replace Comment to replace the current comment on the 

task. 
9. The tasks that will be changed will display in the grid below. Click Update to update the tasks. 
10. A confirmation message displays. Click Yes to continue. 

Viewing the Listing of Safeguard Tasks Report 
The Listing of Safeguard Tasks report creates a list of individuals with Safeguard tasks. The report 
includes the task's status as well as the date the task was updated in ACS, and you can also include 
comments. 

Each individual's name, address, and phone number is included on this report, which is helpful if you 
need to get in touch with a background check applicant with questions.  

You can customize this report for specific Safeguard tasks. For example, you track individuals with 
permission to drive the church vehicle, and it's time to request new background checks for them.  You 
can set up the report to only include individuals with the Drive Church Vehicle task. The report also 
displays the task's status and the date the task was last updated in ACS. You can then use this report 
to see which drivers haven't had a recent background check. 
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To generate this report, you must have View rights to Safeguard Comments and Safeguard Tasks. To 
learn more, see Setting up Background Check Permissions. 

To view the Listing of Safeguard Tasks 

1. Under Searches and Reports, click the Reports tab. 

2. In the drop-down list, select People Reports, then click Go . 
3. In the upper sidebar, under People Reports, expand Lists. 
4. Select the Listing of Safeguard Tasks report and click Customize. 
5. On the Report Options tab, select any options to exclude or include on the report. 
6. To view a listing for a specific task, under Formatting, select Print Safeguard Tasks, then click 

Select. Use the arrows to choose which tasks to print. 
7. Click Preview. 

Background Check Documents and Consent Forms 
Federal law requires that an individual give his or her signed consent to perform a background check. 

You can obtain this electronically and create customized forms for your organization. 

Electronic Consent 
When requesting a background check inside Verified First, you can send individuals an electronic form 

to verify information and consent. This protects applicants by allowing them to enter their personally 

identifiable information at their convenience. 

1. Under Manage Records, click the People tab.  
2. In the drop-down list, select View/Edit Individual and click Go  . 
3. Select the individual whose background check you are requesting and click View/Edit.  
4. On the Safeguard tab, click Request Background Check. You will be redirected to Verified First, 

a separate Web application used for the background checks.  
5. If prompted, enter your Verified First Username and Password in the fields, click Log In. To save your user 

name and password, select Remember Me.  
6. When the order form displays, verify the applicant's Personal Information, which is uploaded from 

ACS People Suite. 
7. In the drop-down list, select the appropriate Package based on which background check you're 

requesting. 
8. To email the applicant a link to consent to and complete the background check, click Send Invite. 
9. Read the certification message that displays, select the checkbox, and click Send. 

Requesting Background Checks 

On the Safeguard tab, you can request background checks.  
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You can also add tasks to track an individual's background checks and the results. If you need to 

request an updated background check after a period of time, you can also do that on this tab.  

To request a background check 

1. Under Manage Records, click the People tab.  
2. In the drop-down list, select View/Edit Individual and click Go . 
3. Select the individual whose background check you are requesting and click View/Edit.  
4. On the Safeguard tab, click Request Background Check. You will be redirected to Verified First, a 

separate Web application used for the background checks.  
5. If prompted, enter your Verified First Username and Password in the fields, click Log In. To save your user 

name and password, select Remember Me.  
6. When the order form displays, verify the applicant's Personal Information, which is uploaded from 

ACS People Suite. 
7. In the drop-down list, select the appropriate Package based on which background check you're 

requesting. 
8. To email the applicant a link to consent to and complete the background check, click Send Invite. 

To enter the background check information yourself, click Next. 
9. If you enter the background check information yourself, enter any required information in each step, 

then click Next. If the information is on the applicant's individual record in ACS People Suite, it 

displays in the fields. 

After you request a background check, you may want to enter a Safeguard task to track when it was 

requested. You can enter information about the results in the comments, and only those with 

adequate permissions in ACS can view them. 

Once background checks are complete, you'll receive an email from Verified First., and you can view 

the results inside ACS. 

  

Requesting Background Checks for Multiple Individuals 
You can request background checks on multiple individuals, which is helpful if you need to run several 

background checks on individuals who have something in common, such as children's church 

volunteers, nursery workers, or teachers in your school. You can search for those individuals, set up 

Safeguard tasks, and run background checks at once. 

You can review all individuals before submitting background check requests. If an individual's profile is 

missing information needed for a background check (such as an email address), this displays as well. 

Before you can request background checks for multiple individuals, you must have permission to 

Safeguard Tasks Mass Create and Update in Add/Edit Users. 

To request background checks for multiple individuals 

1. Under Searches and Reports, click Searches.  
2. Select the appropriate options from the Search Information and Search Criteria tabs to perform 

your search.  
3. Click Process on the Search Criteria tab to process the search.  
4. Click OK.  
5. On the Search Information tab, click Background Check.  
6. To confirm that you want to run background checks for the records on the Results tab, click Yes. 
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7. The Background Checks Bulk Lists results window displays. To view records that cannot be 

processed and the reasons why, click List of Invalid Records. Otherwise, click Continue. 
8. To create Safeguard tasks for the records uploaded, click Yes when the confirmation message 

displays. 
9. When the Submit Background Check window displays, log into Verified First to request the 

background checks. To learn more about requesting background checks, see Requesting 

Background Checks. 

Once background checks are complete, you'll receive an email from Verified First., and you can view 

the results inside ACS. 

Reviewing Background Check Results 
With adequate security rights, you can review background checks you have requested to see the 

status, individual who ordered the background check, date completed, and full details of the results. 

To Review Background Check Results 

1. Under Manage Records, click the People tab.  
2. In the drop-down list, select View/Edit Individual and click Go . 
3. Select the individual whose background check you want to review and click View/Edit.  
4. On the Safeguard tab, click Review Background Checks.  
5. In the Review Background Checks window, select the result you want to view, then click View. 
6. If prompted, enter your Verified First Username and Password in the fields and click Log In. If you want to 

save your user name and password, select Remember Me.  
7. After you log in, expand the Complete tab to view background checks results. 

After reviewing the full results, you can use Safeguard Tasks to enter and track when an individual had 

a background check and any other information about the results. Staff members who do not have full 

access to request and review background checks within Verified First can view these tasks, dates, and 

comments.  

  

 Requesting Updated Background Checks 
Your church may require volunteers to undergo updated background checks at the beginning of each 

school year.  In Searches, you can find who need updated background checks and request them. 

You can also use the Safeguard option under Available Fields in the Search Criteria tab to search for 

individuals who have had background checks conducted or who need to have them done. For 

example, if you want to run a new background check for all volunteers who had background checks 

conducted during January of the previous year, you can search for all volunteers checked the previous 

January and request background checks on those volunteers again. 

To request updated background checks for multiple individuals 

1. Under Searches and Reports, click Searches.  
2. Select the appropriate options from the Search Information and Search Criteria tabs to perform 

your search.  
3. Click Process on the Search Criteria tab to process the search.  
4. Click OK.  
5. On the Search Information tab, click Background Check.  
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6. To confirm that you want to run background checks for the records on the Results tab, click Yes. 
7. The Background Checks Bulk Lists results window displays. To view records that cannot be 

processed and the reasons why, click List of Invalid Records. Otherwise, click Continue. 
8. To create Safeguard tasks for the records uploaded, click Yes when the confirmation message 

displays. 
9. When the Submit Background Check window displays, log into Verified First to request the 

background checks. 

Requesting Updated Background Checks for One Individual 
You can request an updated background check for one individual, which is similar to requesting an 

initial background check. To learn more, see Requesting Background Checks. 

To request an updated background check 

1. Under Manage Records, click the People tab.  
2. In the drop-down list, select View/Edit Individual and click Go . 
3. Select the individual whose background check you are requesting and click View/Edit.  
4. On the Safeguard tab, click Request Background Check. You will be redirected to Verified First, a 

separate Web application used for the background checks.  
5. If prompted, enter your Verified First Username and Password in the fields, click Log In. To save your user 

name and password, select Remember Me.  
6. When the order form displays, verify the applicant's Personal Information, which is uploaded from 

ACS People Suite. 
7. In the drop-down list, select the appropriate Package based on which background check you're 

requesting. 
8. To email the applicant a link to complete the background check, click Send Invite. To enter the 

background check information yourself, click Next. 
9. If you enter the background check information yourself, enter any required information in each step, 

then click Next. If the information is on the applicant's individual record in ACS People Suite, it 

displays in the fields. 
 

Maintaining Background Checks 
Each month, our background check partner, Verified First, purges background checks that are older 

than two years. This purge does not change the background check information that's stored on the 

Safeguard tab. 

Based on the Verified First End-User Agreement (Page 1 Section 4 Item C), you must have a 

reasonable procedure for maintaining and storing these older background checks. You can do this by 

exporting your data from Verified First and storing these as PDF files in a secure location outside of 

ACS. 

Here are some suggestions for maintaining your background checks 

Download your background check files in the PDF file format. 
Save any disclosure and authorization forms as PDFs as well. 
Store these files in a secure location outside of ACS. 

https://links.acstechnologies.com/go.acs?id=130026
https://links.acstechnologies.com/go.acs?id=130026
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Verified First sends an email at the beginning of each month that lets you know if any of your 

background check data will be purged that month. You'll only receive this email if you ran one or more 

background checks two years prior during that month. 

Each email includes information on when your data will be purged as well as instructions on how to 

download your background checks. 

To export data from Verified First 

1. In the email from Verified First, click the link to log into your Verified First account. 
2. Export your data from Verified First . You can download PDFs and attachments for multiple reports at 

one time. 
 

  

https://help.verifiedfirst.com/hc/en-us/articles/360029174632-Exporting-Report-Data
https://help.verifiedfirst.com/hc/en-us/articles/360029174632-Exporting-Report-Data
https://help.verifiedfirst.com/hc/en-us/articles/360029174632-Exporting-Report-Data
https://help.verifiedfirst.com/hc/en-us/articles/360029174632-Exporting-Report-Data
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ACS Sync 
Using ACS Sync, you can upload records to the ACS Server using Access ACS. 

• Configuring your Proxy Settings for Uploading Records 

• Creating an Access ACS Account to Upload Records 

• Uploading Records to Access ACS 

• Working with Change Requests 

• View Logs 

• Sync with DioOffice 

 

Configuring your Proxy Settings for Uploading Records 
If you are using a proxy server, then you will need to configure your proxy settings when you upload 

records. These settings tell your computer how and where to upload the files. 

You can also set up security settings for the upload through the proxy settings. You can select to 

require firewall authentication every time the upload process is run. 

To configure your proxy settings 

1. In the Upload Records window, click Configure. The Internet Connection Settings dialog box displays. 
2. Enter your Proxy Server Address, Proxy Server Port Number, User identification, and Password. 
3. Select Firewall authentication required if you want to require authentication every time you upload 

records. 
4. Click OK. 
 

Creating an Access ACS Account to Upload Records 
To sign up for Access ACS, you must be working on a computer with ACS People Suite installed. 

To sign up for Access ACS: 

1. Log into ACS People Suite. 
2. Under Advanced Tools, click on the Admin Utilities tab. 

3. In the drop-down list, select Sync with Access ACS, and click Go . 
4. In the Access ACS Activation window, select I accept the Terms of Use.  
5. Click Continue. 
6. Complete the Access ACS Registration form, and click Finish.  
7. When the confirmation message displays, click OK. 
8. Check your email for sign in information. 

Important Information 

If you receive a security warning asking if you want to install Signup.ocx, click Install. You 

must install this file to continue with the sign up process. It does not harm your computer or 

any software. 
Access ACS is an additional service for Desktop customers, but it is automatically included with 
all ACS OnDemand subscriptions at no additional monthly cost. Learn more about pricing. 

https://wiki.acstechnologies.com/display/ACSDOC/People
http://www.acstechnologies.com/products/acs/features/access-acs
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When you receive the email, you can sign into Access ACS for the first time. 

Uploading Records to Access ACS 
As an ACS administrator, you can upload ACS records to Access ACS. 

By default, all of your ACS records will be uploaded to Access ACS. But, if you want to upload only 

specific records, you can search for the ACS records that you want to upload. You can upload them 

according to your last search results or a saved search. 

Once you know which records you want to upload, you can select specific data within those records to 

upload. 

To upload records to Access ACS 

1. Under Advanced Tools, click the Admin Utilities tab. 

2. In the drop-down list, select Sync with Access ACS, and click Go . The Upload to Access ACS 

window displays. 
3. Mark your selections, and click Upload to complete the process. 
 

Schedule Uploads 
You can schedule your ACS People data uploads to Access ACS when you're away from the office so 

they don't interfere with your productivity. 

The setup options window is where you select to run your uploads to Access ACS as a scheduled 

task. You also have the option to apply your change requests before uploading to Access ACS (this 

doesn't include flagged change requests). 

When ACS performs a scheduled upload to Access ACS, it always uses the upload selections for your 

most recent manual upload. So, if you change your upload selections, you must first run a manual 

upload before the scheduled upload can detect your new selections. 

For example, let's say you select to include phone numbers in the uploads but no longer include 

contributions. You'll need to run a manual upload with those new selections before they'll be included 

in scheduled uploads. 

If you update your data, you must rerun your searches if you select the Last Search Results option or 

the Organizations Search Results option. For example, your church added two new members since 

your last upload to Access ACS. In that case, you'll need to rerun your search in order to include that 

new information in the upload. 

ACS OnDemand 

If your church uses ACS OnDemand, see Scheduling Tasks to learn more about scheduling your 

uploads to Access ACS. 

ACS for Windows 

If your church uses ACS installed locally or on a network, your computer must be turned on in order to 

run a scheduled Access ACS upload. 

https://wiki.acstechnologies.com/display/AccessACS/Sign+into+Access+ACS
https://wiki.acstechnologies.com/display/ACSDOC/Searches
https://wiki.acstechnologies.com/display/OnDemand/Scheduling+Tasks
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We recommend that you run the scheduled upload with highest privileges.  

To verify that your scheduled upload happened, view the Update Log. 

1. a.  Open the Windows Control Panel. 

a.) Windows 7: On your Windows desktop, click the Start button  in the lower-left corner of the screen. A 

Windows context menu displays. On the right-side panel, click Control Panel. The Control Panel displays. 

b.) Windows 8.1 and Windows 10: On the Windows desktop, right-click the Start button  in the lower-left 

corner of the screen. A Windows context menu displays. Click Control Panel. The Control Panel displays. 

2. Under Administrative Tools, select Task Scheduler. 
3. Under Actions (on the right), select Create Basic Task. 
4. Enter the name of the task (For example, Access ACS Schedule Upload), and click Next. 
5. Select the Trigger for the event, and click Next. 
6. Select the date and time for the task to run, and click Next. 
7. Select Start a program for the task, and click Next. 
8. The Program/Script command should read c:\winacs\acsexport.exe. (or, you can click 

Browse to select this).  
9. In the Add arguments (optional) field, enter -autorun and click Next. 
10. Select Open the Properties dialog for this task when I click Finish (This lets you change 

the settings) and click Finish. 
11. In the Task Properties window, select Run whether user is logged on or not. Click OK.  
12. If you use Windows Server 2008 R2, select Run with Highest Privileges. This lets the 

acsexport process upload data. 
13. Enter your Windows network user name and password, and click OK. 

On the Settings tab, Stop the task if it runs for 72 hours and 0 minutes is selected by default. 

Since Windows does not start one task if the previous one is already running, we recommend 

setting this option to 4 hours on any Windows install. 

There might be times when you have to leave your workstation computer during a scheduled upload. If 

so, we highly recommend you lock the computer instead of signing off. This ensures all network 

connections are still intact and the upload will complete correctly. 

1. On the keyboard, press CTRL + ALT + Delete at the same time. 
2. Click Lock. 

Working with Change Requests 
When someone makes a change to data in Access ACS, this creates a change request. To save the 

change, you must approve and apply it in ACS People Suite.  

For example, James Aaron changes his member status in Access ACS.  
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To review the change request in ACS People, click Change Request.  
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The Change Requests - Overview window displays the number of pending requests for each request 

type. You can view and apply requests individually or apply all requests. 

 

You have more options for managing change requests. Your first step is to select your change 

request setup options 

Change Request Setup Options 
Scheduled Tasks 

You can select to automatically apply change requests before uploading records to Access ACS.  

Flag Change Requests for Review 

You can select the types of change requests you want staff members to review before applying. 

For example, if you select the Last Name check box, all change requests for last names display with a 

green flag next to them. These change requests remain unapplied until a staff member reviews and 

selects them.   

Notifications and Rejection E-mail 

You can send a rejection e-mail for each change request you delete. 
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In some cases, a member might want to reply to the rejection email. In the drop-down list, select the 

staff member who receives these replies. 

To select how you want to be notified of change requests and compose a rejection email message, 

click Change Request Setup. This opens Access ACS. You can edit an entry in the Change Request 

Setup grid to make your notification selections and compose a rejection email message. 

  

To select your change request options 

1. Under Advanced Tools, click the Admin Utilities tab. 

2. In the drop-down list, select Sync with Access ACS, and click Go . The Upload to Access ACS 

window displays. 
3. On the left-side column, click Setup. 
4. Make your selections and click Close. 

 

Apply All Change Requests 
The Overview window displays the number of pending change requests, which are divided into 

categories in a grid. 

From here, an administrator with appropriate rights can apply change requests. 

 

To apply all change requests 

1. Under Advanced Tools, click the Admin Utilities tab. 

2. In the drop-down list, select Sync with Access ACS, and click Go . The Upload to Access ACS 

window displays. 
3. Click Apply All Change Requests. 

 Verify and Apply Change Requests 
 

 

People Change Requests 
People change requests are created when members add or change specific information in Access 

ACS. For example, a member changes their member status or their address. 

To verify and approve People change requests 

1. Under Advanced Tools, click the Admin Utilities tab. 

2. In the drop-down list, select Sync with Access ACS, and click Go . The Upload to Access ACS 

window displays. 

Note 

We recommend that you   before applying them. verify the change requests 

http://10.22.99.19/display/ACSDOC/Setting+People+Suite+Security+Rights
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3. On the left-side column, click People. Before you apply change requests, you can review and edit 

them to make sure the changes are acceptable 
 

New Individual Change Requests 
New Individual change requests are created when new individual records are created in Access ACS. For 

example, a record is created in Access ACS when someone becomes a new member. 

To verify and approve New Individuals change requests 

1. Under Advanced Tools, click the Admin Utilities tab. 

2. In the drop-down list, select Sync with Access ACS, and click Go . The Upload to Access ACS 

window displays. 
3. On the left-side column, click New Individuals. Before you apply change requests, you can review and 

edit them to make sure the changes are acceptable. 
4. Click Apply. 

Attendance Markings Change Requests 
Attendance Marking change requests are created when attendance information is updated in Access 

ACS. For example, you mark attendance for classes and worship. 

To verify and approve Attendance Marking change requests 

1. Under Advanced Tools, click the Admin Utilities tab. 

2. In the drop-down list, select Sync with Access ACS, and click Go . The Upload to Access ACS 

window displays. 
3. On the left-side column, click Attendance Marking. Before you apply change requests, you can review 

and edit them to make sure the changes are acceptable. 
4. Click Apply.  

Group Rosters Change Requests 
Group Rosters change requests are created when group rosters are changed in Access ACS. For 

example, you add a new member to a group roster or drop a former member from a group roster. 

To verify and approve Group Rosters change requests 

1. Under Advanced Tools, click the Admin Utilities tab. 

2. In the drop-down list, select Sync with Access ACS, and click Go . The Upload to Access ACS 

window displays. 
3. On the left-side column, click Group Rosters. Before you apply change requests, you can review and 

edit them to make sure the changes are acceptable. 
4. Click Apply. 
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Connections Change Requests 
Connections change requests are created when connections are changed in Access ACS. For example, 

you create a new Outreach Connection to follow up with new visitors. 

To verify and approve Connections change requests 

1. Under Advanced Tools, click the Admin Utilities tab. 

2. In the drop-down list, select Sync with Access ACS, and click Go . The Upload to Access ACS 

window displays. 
3. On the left-side column, click Connections. Before you apply change requests, you can review and edit 

them to make sure the changes are acceptable. 
4. Click Apply. 

Pledge Change Requests 

Organization Info Change Requests 
Organization Info change requests are created when organization information is changed in Access ACS. 

For example, you update your organization's profile and contact information. 

To verify and approve Organization Info change requests 

1. Under Advanced Tools, click the Admin Utilities tab. 

2. In the drop-down list, select Sync with Access ACS, and click Go . The Upload to Access ACS 

window displays. 
3. On the left-side column, click Organization Info. Before you apply change requests, you can review and 

edit them to make sure the changes are acceptable. 
4. Click Apply. 

  

Organization Staff Change Requests 
Organization Staff change requests are created when organization staff information is changed in Access 

ACS. For example, you add a new staff member. 

To verify and approve Organization Staff change requests 

1. Under Advanced Tools, click the Admin Utilities tab. 

2. In the drop-down list, select Sync with Access ACS, and click Go . The Upload to Access ACS 

window displays. 
3. On the left-side column, click Organization Staff. Before you apply change requests, you can review 

and edit them to make sure the changes are acceptable. 
4. Click Apply. 
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Reject Change Requests 
You can automatically send email notifications when you reject change requests. Access ACS sends the 

emails to the members who originally entered the change requests that you reject. 

To reject a change request 

1. Under Advanced Tools, click the Admin Utilities tab. 

2. In the drop-down list, select Sync with Access ACS, and click Go . The Upload to Access ACS 

window displays. 
3. On the left-side column, click a change request category. 

4. Beside the change request you want to reject, click Delete . 
5. When the confirmation message displays, click OK. 

View Logs 
The View Logs grid is similar to the People Changes Log, but it provides more details. For example, you 

can view the old and new values for change requests. 

Using Filters and Categories  
The grid displays information across seven columns, and you can filter the grid by a specific category. If 

you need advanced filtering results, you can create a custom filter. You can also clear all change 

requests from the View Logs grid, and specify a particular type of change request. 

1. In the View Logs grid, place your cursor over a column heading until you see a drop-down arrow. 
2. Click the drop-down arrow, and select a category. 

1. In the View Logs grid, place your cursor over a column heading until you see a drop-down arrow. 
2. Click the drop-down arrow, and select Custom. The Custom Filter dialog box displays. 
3. Enter your filter values, and click OK. 

1. At the bottom of the View Logs grid, click Clear Log. The Clear Log dialog box displays. 
2. Select the type of change request you want to clear from the log. 
3. Select a date range, then click Clear. 

Need to print the View Logs grid? No problem. 

1. At the bottom of the View Logs grid, click Print. The Print Preview window displays. 
2. Select your printing settings, and click Print. 

 

https://wiki.acstechnologies.com/display/ACSDOC/Working+with+the+People+Changes+Log
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Sync with DioOffice 
If your parish uses ACS People and your diocese uses PDS DioOffice, you can upload ACS People 

records to your diocese using the DioOffice Sync option. 

With the DioOffice Sync option: 

• Upload records based on search results, or on record types and member statuses. 

• Review the records that will be sent and the changes that have been made. 

You must assign security rights to users who will upload these records. 

1. Under Advanced Tools, click the Admin Utilities tab. 

2. In the drop-down list, select Add/Edit Users and click Go . 
3. On the Users tab, select the ACS user whose security rights you want to edit, then click Edit. 
4. In the Edit User window, click on the Security tab. 
5. Expand People and select Sync with DioOffice. 
6. Right-click on the field and select All. 
7. Click Apply, then OK. 

1. Under Advanced Tools, click the Admin Utilities tab. 

2. In the drop-down list, select Sync with DioOffice and click Go . 
3. Enter your Church ID and Password. Once you enter this information, you will not be prompted to 

enter it again, but you will have the option to edit it if necessary. 
4. Enter the Default Area Code. 
5. If you are uploading records based on your last search results, select Use Last Search. If you are 

uploading records based on record type and member status, select Use Selection Below. Select the 

record types you want to upload, and clear the Include All check box to select the member statuses 

you want to upload. 
6. Click Sync. A list of the changes that will be sent to the diocese displays. To view the details of an 

item, select it and click on the Details of the Current Item tab. 
7. Click Sync. 

 

Advanced Exports 
Advanced Export is an advanced version of the People Export you can use to export selected data from 

the People module. You can use this option to generate a customized export file in various file formats. 

The Advanced Export option includes data selection options from the People, Special Mailings, General 

Ledger, and Organizations modules, depending on the modules your organization owns. A solid 

understanding of these modules, as well as an understanding of search and export functionality, is 

important when using Advanced Export. If you have never exported information from ACS using the 

People Export, you should familiarize yourself with that option and its features before performing an 

advanced export. 

As with performing searches, the best way to learn how to perform more complex tasks is to 

experiment. Plan your desired output carefully before you create your export file. By considering the 

fields you need to export data from, the desired organization of the data, and the appropriate file format 

https://wiki.acstechnologies.com/display/ACSDOC/People
https://wiki.acstechnologies.com/display/ACSDOC/People
https://wiki.acstechnologies.com/display/ACSDOC/Special+Mailings
https://wiki.acstechnologies.com/display/ACSDOC/General+Ledger
https://wiki.acstechnologies.com/display/ACSDOC/General+Ledger
https://wiki.acstechnologies.com/display/ACSDOC/General+Ledger
https://wiki.acstechnologies.com/display/ACSDOC/Organizations


 

 26 

for the export, you will save time completing an advanced export. Be sure that you are comfortable 

working in the software application to which you are exporting data. 

While Advanced Exports enables you to export to many different software packages, ACS does not 

support these packages. 
 

Creating a New Advanced Export 
You can create new advanced exports to export specific data for use in other software programs. 

For example, you can use Advanced Export to add Attendance Markings. First, create a Database 

Export. When selecting Included Data, include Personal and Class Rolls, and select the master group 

you want to mark attendance for. 

You can also create an advanced export to print addresses directly on postcards by doing a search for 

those who you need addresses for, then export the names and address through a mail merge. 

1. Under Searches and Reports, click Searches. 
2. On the Search Information tab, click Advanced Export. 
3. On the Advanced Export Menu, click Create New Export. 
4. In the Select Export Type window, select one of the following: 

File Export - Select to create a single file containing selected export information. If you are unsure of 

which type of export you want to perform, select File Export. There is a limit of 254 fields in the File 

Export. 
Database Export - Select to create multiple files that are linked by common fields. 

5. Click OK. The ACS Data Export Designer displays. 
6. In the Export Title field, enter a title for the export. 
7. Optional: To enter a detailed description of the export, click Description. 
8. Select the desired options from the Groups, Fields, and Format tabs (if you are creating a Database Export, 

the tabs available are Groups, Included Data, and Format). Use the Back and Next buttons to navigate the 

tabs. 

 

 
Copying an Advanced Export to a New Name 
Use Copy to New Name on the Advanced Export menu to copy an export to a new file name. This is 

helpful if you want to create a new export that uses similar settings and options as one you've created 

already. You can copy the export, save it with a new name, and make your changes. 

 

1. Under Searches and Reports, click Searches. 

9 .   Do one of the following: 
To save the export and close the ACS Data Export Designer, click  . Save & Close 
To export the information, click  . Run Export 

Tip 

On the Included Data tab, you can select   to include a column for memorials in the export.  CB Gifts 

Note 

If you select a file name that is already in use, the system prompts you to enter a new name. 
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2. On the Search Information tab, click Advanced Export. 
3. On the Advanced Export menu, select the export file you want to copy to a new name. 
4. Click Copy to New Name. 
5. Enter the new name for the export and click OK. 

 

Running an Advanced Export 
After you create a new export and save it, it displays on the Advanced Export menu. Use the Run Export 

option on the Advanced Export menu to execute a saved export. 

1. Under Searches and Reports, click Searches. 
2. In the Searches window, click Advanced Export. 
3. On the Advanced Export Menu, select the export to run, then click Run Export. 
4. A message displays asking if you want to limit the number of records exported for testing purposes. 

Do one of the following: 
o Click OK to export all records 
o Enter the number of records you want to limit the export to for testing purposes and click OK. 

5. When the export is complete, a confirmation message displays. Click OK. 
 

Viewing and Editing Advanced Export Properties 
Use the Properties option on the Advanced Export menu to view and edit the properties of a selected 

export. 

1. Under Searches and Reports, click Searches. 
2. On the Search Information tab, click Advanced Export. 
3. On the Advanced Export menu, select the export file you want to access properties for, then click P 

roperties. 
4. View and/or edit the export properties from the Groups, Fields, and Format tabs (if you are creating 

a Database Export, the tabs available are Groups, Included Data, and Format). 
5. Click Save & Close to save the export and close the ACS Data Export Designer. 

 

Deleting an Advanced Export 
If you no longer need an export, you can delete it. 

1. Under Searches and Reports, click Searches. 
2. On the Search Information tab, click Advanced Export. 
3. On the Advanced Export menu, select the export file to delete, then click Delete Export. 
4. When the confirmation message displays, click OK.  
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Working with the ACS Data Export Designer 
Use the ACS Data Export Designer to select properties for an Advanced Export. The Export Designer 

contains three tabs, depending on the type of export you are performing (File or Database). 

1. Under Searches and Reports, click Searches. 
2. On the Search Information tab, click Advanced Export. 
3. To create a new export, on the Advanced Export Menu, click Create New Export. 
4. To edit an existing export, select the export you want to edit, then click Properties. 
5. Select the appropriate export options. When finished, click Save & Close to return to the Advanced 

Export Menu, or click Run Export to run the export. 

  

If you are performing a File Export, the following tabs display: 

• Groups — Select to export People, Special Mailings Groups, Reservations Activity Rosters, General 

Ledger Accounts, or Organizations data, depending on the ACS modules you own. The Groups 

selection options differ depending on your selection. 

• Fields — Select and arrange the ACS Fields to export. Take some time to familiarize yourself with the 

available fields and options for the field types. 

• Format — Select the file format you want to export your data in. 

If you are performing a Database Export, the following tabs display: 

• Groups — Select to export People, Special Mailings Groups, Reservations Activity Rosters, 

General Ledger Accounts, or Organizations data, depending on the ACS modules you own. The 

Groups selection options differ depending on your selection. 

• Included Data — Select the database tables you want to include in the export. 
• Format — Select the file format you want to export your data in. 

 
The Groups Tab in Advanced Exports 
Use the Groups tab to choose to export either People, Special Mailings Groups, Reservations Activity 

Rosters, General Ledger Accounts, or Organizations data, depending on the ACS modules you own. The 

Groups selection options differ depending on your selection. 

1. Under Searches and Reports, click Searches. 
2. On the Search Information tab, click Advanced Export. 
3. To create a new export, on the Advanced Export Menu, click Create New Export. 
4. To edit an existing export, select the export you want to edit, then click Properties. 
5. Click on the Groups tab, then select the appropriate export options. 
6. When finished, click Save & Close to return to the Advanced Export Menu, or click Run Export to 

run the export. 
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The Fields Tab in Advanced Exports 
Use the Fields tab to select and arrange the ACS Fields to include in the export. The fields available 

depend on your Groups tab selections. Take some time to familiarize yourself with the available fields 

and options for the field types. 

The following information may help in selecting options from ACS Fields: 

• Be sure to view all the available fields in the ACS Fields area. There are multiple layers of fields, so it is 

helpful to take a few moments to familiarize yourself with the setup. 

• Primary fields are fields which serve to identify individual members of the group. These are designated by a 

gold icon in the ACS Fields list. 
• To select fields from the ACS Fields list, you can double-click the desired field or drag and drop it to the 

Selected Fields tab. 

• The Primary Organizations folder found under the Personal folder contains Primary Affiliation fields. 

  

1. Under Searches and Reports, click Searches. 
2. On the Search Information tab, click Advanced Exports. 
3. To create a new export, on the Advanced Export Menu, click Create New Export. 
4. To edit an existing export, select the export you want to edit, then click Properties. 
5. Click on the Fields tab, then select the appropriate export options.  
6. When finished, click Save & Close to return to the Advanced Export Menu, or click Run Export to 

run the export. 
 

The Included Data Tab in Advanced Exports 
Use the Included Data tab to select the database tables you want to include in the advanced export. This 

tab is available when you are performing a Database Export. 

1. Under Searches and Reports, click Searches. 
2. On the Search Information tab, click Advanced Export. 
3. To create a new export, on the Advanced Export Menu, click Create New Export. 
4. To edit an existing export, select the export you want to edit, then click Properties. 
5. Click on the Included Data tab, then select the appropriate export options. 
6. When finished, click Save & Close to return to the Advanced Export Menu, or click Run Export to 

run the export. 
 

The Format Tab in Advanced Exports 
Use the Format tab to select the file format you want to export your data in. 

The file formats you can export your ACS data as using the Advanced Export option are, ACS Report  
Designer, Microsoft® Word, Mail Merge, Microsoft® Excel®, Microsoft® Access®, Microsoft® Outlook®, 

Microsoft® Foxpro, Paradox for Windows, dBase, ASCII Fixed-Length Text File, Comma Separated 

Values, and Tab Separated Values. 
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1. Under Searches and Reports, click Searches. 
2. On the Search Information tab, click Advanced Export. 
3. To create a new export, on the Advanced Export Menu, click Create New Export. 
4. To edit an existing export, select the export you want to edit, then click Properties. 
5. Click on the Format tab. 
6. In the drop-down list, select the appropriate File Format. For some file formats, the Filename option displays. 

Select Filename to select a location to save the file, then click OK. 

 

7. When finished, click Save & Close to return to the Advanced Export Menu, or click Run Export to 
run the export. 

 

Creating an ACS data export file for Surpass 
Surpass is a third-party library automation software. You can create an ACS data export file for Surpass.  

1. Perform a search for the records you want to export to Surpass. 
2. In the Searches window, click Advanced Exports. 
3. The Advanced Export Menu window displays. Click Create New Export.  

 

ACS OnDemand 

Files exported within the OnDemand environment   instead of Microsoft  will open in OpenOffic e 
Office. 

Note 

OnDemand clients can save files to the S Drive and  . transfer them to the local hard driv e 

https://wiki.acstechnologies.com/display/ACSDOC/Conducting+a+Search
https://wiki.acstechnologies.com/display/OnDemand/Viewing+Documents+and+Spreadsheets+in+OpenOffice+Support+Notice
https://wiki.acstechnologies.com/display/OnDemand/Viewing+Documents+and+Spreadsheets+in+OpenOffice+Support+Notice
https://wiki.acstechnologies.com/display/OnDemand/Transferring+Files
https://wiki.acstechnologies.com/display/OnDemand/Transferring+Files
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4. The Select Export Type dialog box displays. Select File Export, and click OK.  

 
5. The ACS Data Export Designer window displays. On the Groups tab, select People. To use only 

records found in the last search, select Use Last Search Results. 

 

6 .   In the ACS Data Export Designer window, click the   tab. Fields 

The order of field selection is critical. Select the fields in the order as listed in the following steps.  

Do not select any other fields, or the import process will fail. 
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7 .   

8 .   

9 .   

Under  , expand  . ACS Fields Personal 

Select the   field, and double-click it to move it to the   tab on the right. Individual ID Selected Fields 

Expand  . Select the   field, and double-click it to move it to the   tab. Checkpoint Bar Code Selected Fields 
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10. Expand Personal > Name. Select the Last Name and First Name fields, and double-click them to 

move them to the Selected Fields tab. 

 

If you do not own Checkpoint, skip the above step. This field is not available. 



 

 34 

11. Expand Personal > Address. Select the Address 1, City, State, ZIP 5, and Home Phone fields, 

and double-click them to move them to the Selected Fields tab. 

 

12. Expand Email Addresses. Select the Home field, and double-click it to move it to the Selected 

Fields tab. 
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13. Expand Personal. Select the Family Position and Member Status fields, and double-click them to 

move them to the Selected Fields tab. 

 

  

After you've selected fields to export, it's time to create the export file.  

1. In the ACS Data Export Designer window, click the Format tab. 
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2. In the File Format drop-down list, select Comma Separated Values (*.csv). 

 
3. Click Filename, The Export Target Filename dialog box displays. 
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4. Click the yellow folder icon 

5.  Enter the file name 

ACStoSurpass. 
6. Click Save, and OK. 
7. In the ACS Data Export Designer window, click Run Export. The Refresh Export dialog box 

displays. 

 

8. Click OK.  
9. When the confirmation message displays that the export is complete, click OK. 
10. In the ACS Data Export Designer window, click Save & Close. The Save Export As dialog box 

displays. 

 

11. In the Title field, enter ACStoSurpass Export and click OK. 

  

Now that you've created your export file, you can edit it for Surpass. You must complete the following 

procedure before you can import your patrons into Surpass. 

The editing procedures are different if you own Checkpoint. If so, you must change the CPBarCode 

column data from a percentage to a number.  

1. Open the ACStoSurpass.csv file in Microsoft® Excel. 

 to select the location to save your export file. 
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2. Click the cell above the HomeEmailUnlisted column heading to select the entire column, and press 

the DELETE key to delete the column. 

 

3. Click the cell name above the CPBarCode column heading to select the entire column (Column B). 

 

4. Select to format the cells. 
5. The Format Cells window displays. On the Number tab, select Text, and click OK.  

 
6. The CPBarCode column data will display as a percentage. 
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7. Click the cell above the LastName column heading to select the entire column. 

 

8. Insert a new column. A new column of blank cells displays. 

 

9. Click in any cell of the blank column, and enter 100. 

  
10. Click in the cell below the one containing 100. Then, click back in the cell containing 100. Rightclick, 

and select Copy. 
11. Click the cell above the CPBarCode column heading to select the entire column. 
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12. Select Paste Special. 
13. The Paste Special dialog box displays. Select Values and Multiply. Click OK.  

 

14. The CPBarCode column changes to whole numbers. 

 
15. Click the cell above the column heading cell in the column that contains the 100 entry. 
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16. Right-click and select Delete. 
17. Save the file. Remember the location of the saved file. 

 

1. Open the ACStoSurpass.csv file in Microsoft® Excel. 
2. Click the cell above the HomeEmailUnlisted column heading to select the entire column, and press 

the DELETE key to delete the column. 

 

3. Insert a new column. To do this, click the cell above the Individualid column heading (column A). 

 

4. Select Insert Cells. A new column A is created. 
5. Click the cell above the IndividualId column heading (column B). Right-click, and select Copy. 

 

6. Click the main column A cell. 
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7. Select Paste Special. 
8. The Paste Special dialog box displays. Select All and None. Click OK. 

 

9. Change the column B heading from Individualid to CPBarCode. 
10. Save the file. Remember the location of the saved file. 

  

After you've created and edited your export file, you must download a program called Pimport. This 

program and template let you import your patron records into Surpass. 

1. In Surpass Central, click Setup, and Patrons. 
2. On the Patrons Types & Limits tab, change the following descriptions. The other patron types are 

not used when importing from ACS.  
For code 1, change the description field to Head. 
For code 2, change the description field to Spouse. 

For code 3, change the description field to Child.  
3. You must set up one custom patron field. In the Setup Patrons window, click the Custom Patron 

Fields tab. 
4. Change the Notes1 description field to Member Status. 
5. Close Surpass Central. 
6. Download Pimport version 5.60 from the Surpass website. Enter the user name and password 

assigned to you by Surpass. 
7. Install Pimport to your Surpass program folder. 
8. Copy the pimport.def template file into the Surpass program folder. 

 

1. On your Windows Start menu, browse to Surpass > Pimport Patron Import. 
2. Enter the appropriate user name and password. 
3. In the Open File window, select the pimport.def file from your Surpass program folder. 
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4. Click Open or Next Step. The Preview window displays. 
5. After previewing your data, on the Import tab, click Next Step. If prompted to perform a Quick 

Backup, exit Pimport, perform the backup, and log back in. If you are not prompted, the import starts 

automatically. 
6. When the import is complete, click Yes to close the application. 

  

If you have any additional questions or need further assistance with Pimport or with any other 

Surpassrelated issue, contact Surpass Support: 

By Phone: 888-313-7678 (toll-free inside the US) or 407-909-1696 (outside the US) 
By Email:  help@surpasssupport.com 
On the Web: www.surpasssupport.com 

   

http://www.surpasssupport.com/
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DataShare 
DataShare lets you synchronize and share people data such as names, addresses, and other 

information. This improves the accuracy of your church and organizational databases, creates a greater 

resource for ministry, saves you time by not having to manually update records, and allows you to send 

more accurate mailings.  

Who Uses DataShare 
Using ACS People, DataShare helps Catholic and Episcopalian diocese to share information about their 

parishioners within the diocesan structure. 

 

Note 

DataShare is only available for purchase by a diocese. Churches and parishes under a diocese that  
have purchased the software can request to connect to their diocese via DataShare. 
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Installing DataShare 
 

For the best user experience, we recommend that you install or upgrade to the latest version of 

ACS People. To determine if you are using the most recent version in the program, go to Online 

Resources, then select Check for Updates. Update the current version .  

 

Back Up Your Data 

1. Open the ACS Backup utility. 

a.) Windows 7: On your Windows desktop, click the Start button  in the lower-left corner of the screen. The 

Start menu displays. Click All Programs > ACS Technologies > ACS Tools > ACS Backup. 

b.) Windows 8.1: On the Windows desktop, click the Start button  in the lower-left corner of the screen. The  

Start screen displays. Click the arrow button . The Apps view displays. In the ACS Technologies section, 

click ACS Backup. 

c.) Windows 10: On the Windows desktop, click the Start button  in the lower-left corner of the screen. The 

Start menu displays. Scroll to the ACS Technologies section, and click ACS Backup. 

Link 
2. Enter your user name and password and click OK. 
3. Under Data Options, select the backup that you want to perform. 
4. Under Additional Options, make the appropriate selections. 

 

6. If you are backing up to a zip disk or a flash drive, insert the disk or drive. 
7. Click Backup. 
8. If you selected to change the filename, enter a filename and click OK. 

Optional: When the backup is finished, click Print History to view or print the Backup/Restore Log 

report. 

Installing the Add-On Module 
When you purchase an add-on module, a new registration key for your ACS software is provided to you.  
Enter the registration key during the installation of your new modules. 

5 .   Verify the backup destination. If necessary, click  Lookup   to select a different location. 

Important 

 Do not back up to the WINACS or ACSNET folders.  
ACS OnDemand users must back up files to the   folder.   S:\ACS_Backups 

http://clientdownloads.acstechnologies.com/Account/LogOn?ReturnUrl=%2fhome%2findex%3fmarket%3d2&market=2
https://wiki.acstechnologies.com/display/UsingthisWiki/_ACS+Backup
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1. On the Windows taskbar, click Start. 
2. Click Programs > ACS Technologies > ACS Tools > Add New Modules. 
3. Enter the client registration information, then follow the on-screen instructions. 

  

1. On the Windows desktop, click the Start button  in the lower-left corner of the screen. The Start 

screen displays. 

2. Click the arrow button . The Apps view displays. 
3. Click Add New Modules. 
4. Follow the instructions as they display. When prompted to enter your Registration Information, 

enter the Registration Key you received when you purchased the new modules. 
 

 

Set User Rights 
Before using DataShare, all connected sites need to set up security rights in Add/Edit Users. The security 

options you select depend on the data you will send and receive. 

For example, if your church or organization needs to send records to a denominational office, 

organization, or diocese, you need access to Send Changes to DataShare. If the denominational office 

or diocese changes records that also need to be updated in your database, you need access to Get 

Changes from DataShare. 

If you do not want volunteers to send and receive updated information in DataShare, select None. Users 

who do not have access to DataShare still see updated records after changes are received. 

1. Under Advanced Tools, click the Admin Utilities tab. 

2. Select Add/Edit Users and click Go . 
3. On the Users tab, select the user whose DataShare security options you want to grant or restrict, 

then click Edit. 
4. In the Edit User window, on the Security tab, expand DataShare. 
5. If granting access to DataShare, under Access, select All for Get Changes from DataShare or Sen 

d Changes to DataShare. 
6. If restricting access, select None for Get Changes from DataShare or Send Changes to 

DataShare. 
7. Click OK. 

  

For those using 60-Day Evaluation versions 

If you enter data that makes your live data unusable, ACS Data Services can clean up your  
data for a fee. 
If you want to use a demo dataset, contact ACS Customer Support at 1-800-669-2509 for  
assistance. 
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Granting and Restricting DataShare Access 
Before using DataShare, all connected sites need to set up security rights in Add/Edit Users. The security 

options you select depend on the data you will send and receive. 

For example, if your church or organization needs to send records to a denominational office, 

organization, or diocese, you need access to Send Changes to DataShare. If the denominational office 

or diocese changes records that also need to be updated in your database, you need access to Get 

Changes from DataShare. 

If you do not want volunteers to send and receive updated information in DataShare, select None. Users 

who do not have access to DataShare still see updated records after changes are received. 

1. Under Advanced Tools, click the Admin Utilities tab. 

2. Select Add/Edit Users and click Go . 
3. On the Users tab, select the user whose DataShare security options you want to grant or restrict, 

then click Edit. 
4. In the Edit User window, on the Security tab, expand DataShare. 
5. If granting access to DataShare, under Access, select All for Get Changes from DataShare or Sen 

d Changes to DataShare. 
6. If restricting access, select None for Get Changes from DataShare or Send Changes to 

DataShare. 
7. Click OK. 

 

Getting DataShare Changes From Connected Sites 
Getting changes from connected sites allows you to upload new records to your database, change 

existing records that were modified in the connected site's database, and deletes records that were 

deleted from the connected site's database. DataShare sends information from the connected site's 

database to your database and the receiving site gets changes from the connected sites. 

To know what information has changed, you'll receive updated information about: 

• each individual's Profile tab in View/Edit Individual any new 

individuals who has been added to the connected site's database 

• any individual who was deleted from the connected site's database 

When the connected site sends their changes to DataShare for your database to receive them, the 

changes are not automatically applied to your database. You can review new, updated, and deleted 

individuals, then decide which ones to accept, reject, postpone, or ignore forever. 

1. Under Advanced Tools, click the Admin Utilities tab. 

2. In the drop-down list, select Get Changes from DataShare and click Go . 

3. In the DataShare - Get Changes window, click Next  to establish a connection. 
4. Under Download Options, select the site you want to download changes from in the drop-down list. To 

download changes from every site, select All connected sites. 
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5. Click Connect. Once DataShare connects and receives changes, the number of new, updated, and 

deleted individuals displays under Summary. 
6. If any fields need to be mapped, click on the field to select a mapping. 

7. Click Next . 
8. If this is your first time getting data from a church or organization, right-click on the site's name to map 

it to an existing record in ACS Organizations or to set it to Unaffiliated. You can also right-click and 

select Don't map this site to skip this process. 
9. New individuals in the connected site's database display. At the top of the window, right-click on the 

connected site's name and select the applicable option: 
Change Status - Select to change the status for all of the records from the connected site. For example, 
if you select Change Status, then select Accept, DataShare marks all records as accepted. 
Scroll To - Select this option to scroll between connected sites or new families to be added to your 

database. 
Filter - Select Toggle Postpone Filter to hide postponed records. 
Show Search Menu - Select to display a search field at the top of the window so you can search for an 

individual. This is helpful if you want to ensure that an individual or family's record is included. 
Select Group - Choose this option to select every record for the connected site. This is helpful if you 

want to accept all new individuals, because it allows you to mark every record as accepted. 
Auto Match Selected - Select to automatically match the selected individuals to records already in your 
database. This is helpful because it prevents duplicate records from being created if a new individual 

already has a record in ACS. To auto match all records from the connected site, choose Select Group.  
You'll need to select the group and Auto Match Selected for each connected site. 
Manual Match Selected — Select this option to manually match records. 
Clear Matching — Select this option to un-match records. 
Visual Compare — This option is available for matched records. Select this option to compare an individual's 

information from your database with the information from the connected site's database. 

Tip 

You can exit the Visual Compare window by pressing one of three keys: ESCAPE, ENTER, or the SPACE 

BAR. 

Change Organization Mapping - Select to map the connected site to an organization in ACS 

Organizations. When selected, individuals are affiliated with this organization after you upload records. 

Don't Map this Site - Select to import individual records without setting an affiliated organization.  
10.  Select each individual's record, then click the appropriate button or press the applicable key. As you 

select each individual, his or her name, address, and status (Accepted, Rejected, Postponed, or 

Ignored Forever) displays. 
Accept (Hot Key A) - Adds the new individual to your database. 
Reject (Hot Key S) - Does not add the individual to your database. 
Postpone (Hot Key D) - Does not add the individual to your database. The new individual's record 

continues to display when you get changes from DataShare, unless you accept, reject, or ignore it 

forever. 
Ignore Forever (Hot Key F) - Does not add the individual to your database. Any future changes to this individual's 

record will not be sent to your site. For example, if the connected site has an individual record for "Loose Change" 

where they record loose change contributions, you could select this option to avoid being prompted to add this record 

each time you get changes. With this option, a blue link will display at the bottom of the window below the Summary 

section. Click the blue link to view a list of all the records you have chosen to ignore. 
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Mapping Fields in DataShare 
Since every database's setup differs, you may need to map fields in your database when you get 

changes from connected sites. 

 

 

Fields are saved once you map them, but you can view and edit saved mappings. 

1. Under Advanced Tools, click the Admin Utilities tab. 

2. In the drop-down list, select Get Changes from DataShare and click Go . 
3. In the DataShare - Get Changes window, click Next to establish a connection. 
4. Under Download Options, select the site you want to download changes from in the drop-down list. 

To download changes from every site, select All connected sites. 
5. Click Connect. Once connected, the message Status: Changes have been received. Mappings 

must be added for the following new items before proceeding displays, along with a list of fields. 
6. Click on the field you want to map. 
7. In the Mappings window, under Destination, select the field you want to map the connected site's 

field to, then click OK. 
8. Repeat steps 6-7 for each field listed. 
9. Once all fields are mapped, click Next to continue getting changes from DataShare. 

1. Under Advanced Tools, click the Admin Utilities tab. 

2. In the drop-down list, select Get Changes from DataShare and click Go . 
3. In the DataShare - Get Changes, window, click Click Here to view the custom configuration options. 
4. In the Synchronization Settings window, under Mapping Options, click View/Edit Saved Mappings. 
5. In the Mappings window, select the mapping you want to view or edit in the drop-down list. 
6. Make any necessary changes and click OK. 

 
Sending Changes to Connected Sites in DataShare 
A connected church or organization makes changes in data and sends the changes to other DataShare 

sites. DataShare allows you to send information and changes on the Profile tab in View/Edit Individual to 

other sites, based on a saved search or by member status, pledges, and gifts. You must send your data 

changes, additions, and deletions to DataShare in order for other sites to receive them. 

11 .   Click    . Next 

Note 

To select all records, right-click on the connected site's name, then click  .  Select Group 

Examples 

 A connected site's database may contain individuals with the Member Status of  , but your database doesn't have that Member Status. When you map the  Other 
field, you can set those individuals' members statuses to change to another member status that is already defined in your database. 

You may track an organization's address using an address type of  , but a connected site you get changes from may track organization addresses using the  Org 
address type  . Once you map this field, when you receive an   address, the address is listed as an   address in your database. Organization Org Organization 
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The first time you send data, all records that match your selected criteria are sent to the other sites. After 

this, updated records are sent, along with deleted records, so that those records are also deleted at the 

other site. You may change the filter settings of your criteria if you like. 

1. Under Advanced Tools, click the Admin Utilities tab. 

2. In the drop-down list, select Send Changes to DataShare and click Go . 
3. In the Send Changes Filter Options window, select the Filter Settings to use for sending changes. 

Use saved search criteria — Select to send records based on a saved search. For example, if you 
want to send changes to members' records, process and save a search for those with the Member 

Status of Me mber. Then, select the saved search in the drop-down list. 
Use selection below — Select to send records and changes based on pledges, gifts, and member 

status. Then, select to include individuals or families who pledged and/or gave, and select the member 

statuses to include. 
4. When the confirmation message displays, click OK. 
5. In the Send Changes window, individuals whose records match your filter settings display. Click Sen 

d Changes to send these records through DataShare. 
6. Once the records are sent, a confirmation message displays. Click OK, then Close. 
 

Fields sent to DataShare 

The fields below are sent to DataShare connected sites: 

Title 
First Name 
Middle Name or Initial 
Last Name 
Suffix 
Goes By Name 
Address 

Primary Address Fields 
Mailing Address Fields 
Statement Address Fields 

City 
State 

ZIP Code 
Phone 
Phone Listed flag 
E-mail 
Date of Birth 
Marital Status 
Gender 
Church the individual is associated with 
Family Position 

Member Status 
Reason Deleted 
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Using Saved Search Criteria in DataShare 
The new and updated records you send to DataShare are based on contributor information or saved 

search criteria. This allows you to send certain records and information to DataShare while excluding 

others. 

For example, you need to send records and information regarding all church members to your diocese or 

organizational office. However, ACS contains records that belong to visitors, those who only attend 

Sunday School, and contributors who are not members of your church.  If your diocese or organization 

office only needs member data, you can define and save a search for all members who have ACS 

records. Then, when you send information to DataShare, using this search ensures the diocese or 

organization gets the data they need. 

1. On the ACS main menu, click Searches. 
2. On the Search Information tab, select the appropriate settings for your search. 
3. Click on the Search Criteria tab, then select the criteria for your search. 
4. Process the search, then click the Search Information tab. 
5. Click Save Criteria. 
6. Enter a name for the search criteria set in the Title field. 
7. Optional: Select Public if you want other ACS users to have access to the saved criteria. 
8. Click Save. 

1. Under Advanced Tools, click the Admin Utilities tab. 

2. In the drop-down list, select Send Changes to DataShare and click Go . 
3. At the top of the Send Changes window, select Click Here to adjust your filter settings. 
4. In the Send Changes Filter Options window, select Use saved search criteria, then select the 

search you just saved. 
5. Click OK. 
6. When the Send Changes window displays the updated records, click Send Changes to send these 

records through DataShare. 
7. When the records are sent and the confirmation message displays, click OK, then Close. 

 

PhoneTree and VoiceWave 
PhoneTree® is a voice message delivery system that is compatible with ACS. You can use it to let others 

know about upcoming events. In addition, it is especially helpful for notifying people of event delays or 

cancellations, such as in the case of inclement weather. 

  

  

PhoneTree and VoiceWave Support 

ACS Support provides help for creating the file in ACS to import into PhoneTree or VoiceWave. 
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Sending ACS Data to VoiceWave 
You can use the PhoneTree Export to generate a file to use with VoiceWave™. In ACS, you will select 

the people you want to include through a search, then export their contact information using the 

PhoneTree Export. 

Once you export your ACS data, you can import it into VoiceWave and start sending messages. 

In the PhoneTree Export, you can select which method and type of contact information you want to use.  
You can export either: 

 Each person's preferred contact method and type (whether it be phone, text, or e-mail). 
Contact methods and types that you select specifically, such as "work phone," "home email," or "cell 

text." 

1. Under Searches and Reports, click the Reports tab. 

2. In the drop-down list, select People Reports and click Go . 
3. In the upper sidebar, expand Extracts, then select PhoneTree Export. 
4. In the lower sidebar, click Customize. 
5. Under PhoneTree Options, select VoiceWave Online. 
6. Select your Export Options. 

7. Optional: If you want to change the file name or the location to save the file, click  in the 

Filename field. 
8. Click Extract. 
9. If a previous PhoneTree Export file exists, a message displays confirming that you want to overwrite 

it. Click OK. 
10. When the confirmation message displays, click Yes. 

 

Sending ACS People Data to PhoneTree 
You can export your ACS data to use with PhoneTree®. In ACS, you will select the people you want to 

include through a search, then export their contact information using the PhoneTree Export. 

You can export contact information on a per family or per person basis, and you can also choose what 

contact information to export. For families, you can select home or preferred phone numbers, and you 

can include e-mail addresses. For individuals, you can select home, preferred, or other phone numbers, 

and you can also include e-mail addresses. 

Exporting Contact Information from ACS 

 

You will export your ACS data through the PhoneTree Export in People reports. Before you begin, 

process a search on the individuals you want to include in the export file. 

1. Under Searches and Reports, click the Reports tab. 

2. In the drop-down list, select People Reports and click Go.  
3. In the upper sidebar, expand Extracts, then select PhoneTree Export. 

https://wiki.acstechnologies.com/display/ACSDOC/Searches
https://wiki.acstechnologies.com/display/ACSDOC/Searches
https://wiki.acstechnologies.com/display/ACSDOC/Searches
https://wiki.acstechnologies.com/display/ACSDOC/Searches
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4. In the lower sidebar, click Customize. 
5. Under PhoneTree Options, select the file type according to what version of PhoneTree you are using. 
6. Select any additional report options (see Additional Information for details), then click Extract. 

 

7. If a previous PhoneTree Export file exists, a message displays confirming that you want to overwrite 

it. Click OK. 
8. When the confirmation message displays, click Yes. 

PhoneTree Exception Report 

The confirmation message may include a notice that records were excluded because they have invalid or 

duplicate contact information. If you get this message, click Yes to view the PhoneTree Exception 

Report. 

The report lists individuals who are excluded from the export because they had duplicate or no contact 

information available for the selected methods and types. The list includes the available contact 

information for the excluded individuals. 

Importing ACS Data into PhoneTree 

 

After you have exported your ACS data, you can import it into PhoneTree and start sending messages.  
This procedure varies depending on your version of PhoneTree. 

1. Open PhoneTree. 
2. On the PhoneTree tab, click the numbered PhoneTree icon where you want to store the extract. 
3. On the Import menu, click Import. 
4. Select CSV. 
5. In the Look in field, select the location where you saved the extract file. 
6. In the File name field, select the file you want to import. 
7. Click Open. 
8. In the Import Data window, select if you want to overwrite, append, or create a new file. 
9. Click Configure. 
10. Verify that the Last Name, First Name, and Phone are correct, then click OK. 

 

1. Open PhoneTree. 
2. On the PhoneTree Desktop, click Select. 
3. Select the PhoneTree you want to use, and then click Go to PhoneTree. 
4. Click OK. 
5. Enter a file name for the import, then click OK. 
6. On the Import menu, point to Custom, and then click ACS. 
7. In the Look in field, select the location where you saved the extract file. 8.  In the File name field, 

select the file you want to import and click Open. 

Useful Information 

Be sure to use a file name without spaces. Otherwise, you may receive an error. 
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8. When the Import Query window displays, click the appropriate answer. 
 

Sending Special Mailings Data to PhoneTree 
You can export ACS Special Mailings information to use with PhoneTree®. 

ACS automatically exports the home phone number for each person, and you can also export other 

phone numbers and e-mail addresses. You can also select the Special Mailings groups you want to 

export. 

Exporting Contact Information from ACS 

 

You will use the PhoneTree Export within Special Mailings reports to generate the file. 

1. Under Searches and Reports, click the Reports tab. 

2. In the drop-down list, select Special Mailings Reports and click Go.  
3. In the upper sidebar, expand Extracts, then select PhoneTree Export. 
4. In the lower sidebar, click Customize. 
5. Under PhoneTree Options, select the file type according to what version of PhoneTree you are using. 
6. To export the contact information of specific groups, under Export Options, select Selected Groups 

and click Select. 
7. Select any additional report options (See Additional Information for details), then click Extract. 
8. If a previous PhoneTree Export file exists, a message displays confirming that you want to overwrite 

it. Click OK. 
9. When the confirmation message displays, click Yes. 

PhoneTree Exception Report 

The confirmation message may include a notice that records were excluded because they have 

invalid or duplicate contact information. If you get this message, click Yes to view the 

PhoneTree Exception Report. 

The report lists individuals who are excluded from the export because they had duplicate or no 

contact information available for the selected methods and types. The list includes the available 

contact information for the excluded individuals. 

Importing ACS Data into PhoneTree 

 

After you have exported your ACS Special Mailings data, you can import it into PhoneTree and start 

sending messages. Instructions vary depending on your version of PhoneTree. 

1. Open PhoneTree. 
2. On the PhoneTree tab, click the numbered PhoneTree icon where you want to store the extract. 

https://wiki.acstechnologies.com/display/ACSDOC/Special+Mailings
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3. On the Import menu, click ACS Import. 
4. In the Look in field, select the location where you saved the extract file. 
5. In the File name field, select the file you want to import. 
6. Click Open. 

1. Open PhoneTree. 
2. On the PhoneTree Desktop, click Select. 
3. Select the PhoneTree you want to use, and then click Go to PhoneTree. 
4. Click OK. 
5. Enter a file name for the import, then click OK. 
6. On the Import menu, point to Custom, and then click ACS. 
7. In the Look in field, select the location where you saved the extract file. 8.  In the File name field, 

select the file you want to import and click Open. 
9.  When the Import Query window displays, click the appropriate answer. 

 

Sending Reservations Data to PhoneTree 
You can export contact information for those involved in a Reservations activity to use with PhoneTree®. 

ACS Reservations automatically exports the home phone number for each person, and you can also 

export other phone numbers and e-mail addresses. 

Exporting Contact Information from ACS 

 

You will use the PhoneTree Export within Reservations reports to generate the file. 

1. Under Searches and Reports, click the Reports tab. 

2. In the drop-down list, select Reservations Reports and click Go.  
3. In the upper sidebar, expand Extracts, then select PhoneTree Export. 
4. In the lower sidebar, click Customize. 
5. Under PhoneTree Options, select the file type according to what version of PhoneTree you are 

using. 
6. To export the contact information of specific activities, under Export Options, select Selected 

Activities and click Select. 
7. Manage the other settings to your liking. See Additional Information for details. 
8. Click Extract. 
9. If a previous PhoneTree Export file exists, a message displays confirming that you want to overwrite 

it. Click OK. 
10. When the confirmation message displays, click Yes. 

PhoneTree Exception Report 

The confirmation message may include a notice that records were excluded because they have 

duplicate or invalid contact information. If you get this message, click Yes to view the 

PhoneTree Exception Report. 

https://wiki.acstechnologies.com/display/ACSDOC/Reservations
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The report lists individuals who are excluded from the export because they had duplicate or no 

contact information available for the selected methods and types. The list includes the available 

contact information for the excluded individuals. 

Importing ACS Data into PhoneTree 

 

After you have exported your ACS data, you can import it into PhoneTree and start sending messages.  
Instructions vary depending on your version of PhoneTree. 

1. Open PhoneTree. 
2. On the PhoneTree tab, click the numbered PhoneTree icon where you want to store the extract. 
3. On the Import menu, click ACS Import. 
4. In the Look in field, select the location where you saved the extract file. 
5. In the File name field, select the file you want to import. 
6. Click Open. 
1. Open PhoneTree. 
2. On the PhoneTree Desktop, click Select. 
3. Select the PhoneTree you want to use, and then click Go to PhoneTree. Click OK. 
4. Enter a file name for the import, then click OK. 
5. On the Import menu, point to Custom, and then click ACS. 
6. In the Look in field, select the location where you saved the extract file. 7.  In the File name field, 

select the file you want to import and click Open. 
8.  When the Import Query window displays, click the appropriate answer. 

  

Sending E-mails 
ACS lets you build a list of e-mail recipients based on your ACS records. For example, you might e-mail 

the parents of children between the ages of two and ten to remind them about registering for Vacation 

Bible School. To do this, generate a search for the parents in ACS, select them as your e-mail recipients, 

and then choose your e-mail method. Depending on the method you select, you may have to configure it 

before you start sending e-mails. 

In ACS, you can send mass e-mails, which send the same e-mail message to everyone in a group. Or, 

you can send personalized e-mails by selecting fields to include, similar to a mail merge option in word 

processing software. 

With ACS, you can send e-mails to Special Mailings groups, Reservations activities, and records found in 

S earch results. 

After selecting e-mail recipients, you must select your e-mail method. You can send e-mails to ACS 

recipients using the ACS E-mail Editor, Constant Contact, or your own e-mail client (such as Microsoft® 

Outlook®).  
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Selecting E-mail Recipients 
ACS lets you build a list of e-mail recipients based on your ACS records. You can send e-mails to the 

people in a Special Mailings group, Reservations activity, or by performing a search. 

After choosing your e-mail recipients, you must select an e-mail method: Constant Contact, The ACS 

Email Editor, or your Local E-mail Client. 

1. Under Manage Records, select the Groups tab. 

2. In the drop-down list, select Special Mailings Add/Edit Groups and click Go . 
3. Select the group. 
4. In the right pane, click Mass E-mail. 
5. Under Recipient Options, manage the settings to your liking. See Additional Field Information for 

details. 

1. Under Manage Records, select the Communication tab. 

2. In the drop-down list, select Reservations Mass E-mail and click Go . 
3. Select the activity and click OK. 
4. Under Recipient Options, manage the settings to your liking. See Additional Field Information for 

details. 

1. Next to Searches and Reports, click Searches. 
2. Create and process a new search. Or, load and process a saved search. 
3. On the Search Information tab, in the right pane, click Mass E-mail. 
4. Under Recipient Options, manage the settings to your liking. See Additional Field Information for 

details. 

 

Sending E-mails with Constant Contact 
Constant Contact® is an online marketing company that offers email marketing, social media marketing, 

online survey, and event marketing tools. You can use Constant Contact to send professional e-mails to 

people stored in your ACS records. 

To send e-mails to ACS recipients with Constant Contact 

Add your Constant Contact account to ACS. 
Select your ACS e-mail recipients. 
Send your ACS data to Constant Contact. 

You can also manage what ACS data is sent to Constant Contact. 

 

Adding Constant Contact Accounts to ACS 
To send e-mails to ACS recipients with Constant Contact, you must first add your Constant Contact 

account to ACS. You can then send your ACS data to Constant Contact and create e-mailing lists for 

your ACS recipients. (You must have an active Constant Contact® account.) 

http://acstechnologies.constantcontact.com/index.jsp
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After you add your account, you can select your ACS e-mail recipients and send your ACS data to 

Constant Contact. 

1. Under Manage Records, click the Communication tab. 

2. In the drop-down list, select Mass Email and click Go . 
3. Click Mass Email. 
4. Under E-mail Method, select Constant Contact. 
5. Click Manage Accounts. The Select Account window displays. 
6. Click Add. 
7. In the Account Name field, enter a name to identify your Constant Contact account in ACS. (This 

doesn't have to match your Constant Contact Account information.) 
8. Enter your Constant Contact user name and password and click OK. 
 

Managing the Data Sent to Constant Contact 
In ACS, you can manage what data is sent to Constant Contact. For example, the Goes By name stored 

in ACS is sent to Constant Contact as the first name by default. However, you can change this so that 

the formal first name is sent instead. 

You can also select to send additional information from ACS to Constant Contact. After you do this, the 

data in that field is included when you send data from ACS to Constant Contact. 

1. Under Manage Records, click the Communication tab. 

2. In the drop-down list, select Mass Email and click Go . 
3. Click Mass Email. 
4. Under E-mail Method, select Constant Contact. 
5. Click Manage Accounts. 
6. Select the Constant Contact account and click Edit. 
7. In the ACS column, click the field that corresponds to the information you want to send to Constant 

Contact. 
8. Navigate to and select the ACS field you want to send and click OK. 

 

Sending ACS Data to Constant Contact 
After you have added your Constant Contact account to ACS and selected your e-mail recipients, you 

can send your ACS data to Constant Contact. 

Sending your ACS data to Constant Contact creates an e-mail list in your Constant Contact account. 

After you do this, you can log in to Constant Contact to compose and send your e-mail. 

Creating A New E-mail List 

When you create a new list, all e-mail addresses from your ACS recipients list are added to the Constant 

Contact list. Constant Contact removes any e-mail addresses that have previously opted out of receiving 

emails from you. Unless you select Preferred E-mail Only, the list includes all e-mail addresses for the 

selected recipients. 

http://www.constantcontact.com/
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1. Select your ACS e-mail recipients by performing a search, selecting a Special Mailings group, or 

selecting a Reservations activity. See Selecting E-mail Recipients to learn more. 
2. In the Build E-mail Recipients List window, under E-mail Method, select Constant Contact. 
3. Click Manage Accounts. 
4. Select the Constant Contact account you want to send your ACS data to (To add a new Constant 

Contact account, click Add.) and click OK. 
5. Enter a New List name and click OK. 

Updating An E-mail List 

If you have previously sent ACS data to Constant Contact, you can send it again to update the e-mail list. 

When you update the list, all new addresses are added to the list; existing addresses are left alone. Any 

other information that has changed, such as first names, is updated. Any e-mail addresses that are 

already in the list, but are not returned in the latest search results, are ignored: they are not removed 

from Constant Contact. Constant Contact also ignores any e-mail addresses that have previously opted 

out of receiving emails from you. 

1. Select your ACS e-mail recipients by performing a search, selecting a Special Mailings group, or 

selecting a Reservations activity. See Selecting E-mail Recipients to learn more. 
2. In the Build E-mail Recipients List window, under E-mail Method, select Constant Contact. 
3. Click Manage Accounts. 
4. Select the Constant Contact account you want to send your ACS data to and click OK. 
5. In the Select Contact List, select the e-mail list and click OK. 

 

Sending E-mails with Your Local E-mail Client 

ACS lets you select recipients from your ACS data while using your own e-mail client to compose and 

send the e-mail. Using your own e-mail client (such as Microsoft® Outlook® or Mozilla® Thunderbird®) 

means the e-mail comes from your e-mail address and is stored in your Sent items. This is also the best 

way to send a quick e-mail to ACS recipients, since it requires no additional configuration. 

1. Select your ACS e-mail recipients by performing a search, selecting a Special Mailings group, or 
selecting a Reservations activity. See Selecting E-mail Recipients to learn more. 

2. In the Build E-mail Recipients List window, under E-mail Method, select Copy to local client. 

 

3. Click OK. A blank e-mail opens in your e-mail client. The ACS recipients are listed in the BCC field. 
4. Compose and send your message.  

Useful Information 

 You can set your e-mail batch size up to a maximum of 95. 
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Sending E-mails with the ACS E-mail Editor 
The ACS E-mail Editor lets you send e-mails directly from ACS — no other e-mail client required. 

Before you can send e-mails using the ACS E-mail Editor, you must configure ACS to send e-mails. Then 

you can select your e-mail recipients and compose and send your e-mail. 

You can also save e-mails for future use, generate a recipients report, and use the e-mail spellcheck and 

thesaurus. 

Changing the Status of Recipients 
After you have selected your e-mail recipients, you may decide that you don't want to send the e-mail to 

the majority of the list. Rather than rebuilding your recipients list from scratch, you can mass change the 

sending status of recipients. 

You can change the status of a single recipient or all recipients. You can also change the status based on 

people's e-mail type and whether their address is listed or not. For example, if you don't want to send an 

email to unlisted addresses, you can change the status of all recipients with unlisted addresses to Do not 

Send. 

1. In the E-mail Editor window, click Recipients . 
2. Right-click the recipient. 
3. Select Change Send Status. 

People who will not receive the e-mail display in red with a status of "Do Not Send." 

1. In the E-mail Editor window, click Recipients . 
2. Click Mass Change. 
3. Select Send or Do not Send. 
4. Leave the E-mail Type and Listed options blank. 
5. Click OK. 

People who will not receive the e-mail display in red with a status of "Do Not Send." 

1. In the E-mail Editor window, click Recipients . 
2. Click Mass Change. 
3. Select E-mail Type. 
4. In the drop-down list, select the e-mail type. 
5. Select Send or Do not Send. 
6. Click OK. 

People who will not receive the e-mail display in red with a status of "Do Not Send." 

1. In the E-mail Editor window, click Recipients . 
2. Click Mass Change. 
3. Select Listed. 
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4. In the drop-down list, select True or False. (True means the addresses are listed; false means the 

addresses are unlisted.) 5.  Select Send or Do not Send. 
6.  Click OK. 

People who will not receive the e-mail display in red with a status of "Do Not Send." 

Configuring ACS to Send E-mails 
Before you can send emails with ACS, you must configure ACS to send emails. You must have rights to 

Ad d/Edit SMTP Settings in Add/Edit Users to set up the configuration. 

If you change internet service providers, you must update your SMTP address to send emails.  

OnDemand clients will configure ACS to send emails using the OnDemand configuration. 

1. Under Manage Records, click the Communication tab. 

2. In the drop-down list, select Mass Email and click Go . The Searches window displays. 
3. Click Mass E-mail. The Build E-mail Recipients List dialog box displays. 
4. Under E-mail Method, select Use local SMTP, and click OK. The E-mail Editor window displays. 

5. Click the E-mail Accounts drop-down list, and select  Manage E-mail Accounts. The SMTP List 
window displays. 

6. Click Add. The Add SMTP dialog box displays. 
7. Enter the following information: 

Your SMTP server address. If you don't know your server address, see Finding Your SMTP 

Address. Your port number. (You can accept the default port number.) Your security type (for data 

encryption). 
To verify that the sending email address is recognized by your server select Authenticate. 

Authentication decreases the possibility that your emails are blocked by a firewall or other security 
settings. 
To encrypt the email, select Use SSL. 
To require a password before each email is sent, select Verify Password on Send. 

Your user name. This is the user name for your Internet Service Provider email account. 
Your password. This is the password for your Internet Service Provider email account. 

8. Click OK. 

Now you can select your e-mail recipients and then compose and send your e-mail. 

Finding Your SMTP Address 
You must know your SMTP server address to configure ACS to send emails. An SMTP address displays 

in one of the following formats: 

 As a series of numbers, such as 213.109.213.098 
As a descriptive location, such as microsoft.mailserver.com 

1. Open the Run window. 

a.) Windows 7: On your Windows desktop, click the Start button  in the lower-left corner of the 

screen. The  

Start menu displays. In the search box, located at the bottom of the Start menu, type run. Click  Run. The 

Run window displays. 

https://wiki.acstechnologies.com/display/ACSDOC/Utilities+Security+Rights
https://wiki.acstechnologies.com/display/ACSDOC/Utilities+Security+Rights
https://wiki.acstechnologies.com/display/OnDemand/Setting+up+Bulk+E-mail
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b.) Windows 8.1 and Windows 10: On the Windows desktop, right-click the Start button  in the 

lower-left corner of the screen. A Windows context menu displays. Click Run. The Run window 

displays. Link 
2. Type CMD, and click OK. The Windows Command Prompt application opens. 
3. Type ping smtp.mysite.com. 

 If this returns an error, type ping mail.mysite.com instead. 
Your SMTP address is listed directly after the word "Pinging." See an example below. Once you have 

determined your SMTP address, you can return to configuring ACS to send e-mails. If you have 

trouble determining your SMTP address, contact your Internet service provider. 

 
 

Composing and Sending E-mails 
Once you have configured ACS to send e-mails and selected your e-mail recipients you can compose 

and send your e-mail with the ACS E-mail Editor. After you click Send, the progress meter and checklist 

display to notify you when the e-mail is sent. 

You may also want to save the e-mail for future use, generate a recipients report, change the status of all 

recipients, and manage the e-mail spellcheck and thesaurus. 

 

1. Select your ACS e-mail recipients by performing a search, selecting a Special Mailings group, or 

selecting a Reservations activity. See Selecting E-mail Recipients to learn more. 
2. In the Build E-mail Recipients List window, under E-mail Method, select Use local SMTP. 
3. Click OK. The ACS E-mail Editor opens. 

Note 

If you are an OnDemand client and are attaching a file to your e-mail, you should copy that file from  
your hard drive to the S drive first.  . View more informatio n 

https://wiki.acstechnologies.com/display/UsingthisWiki/_Run+Command
https://wiki.acstechnologies.com/display/OnDemand/Managing+Your+Files
https://wiki.acstechnologies.com/display/OnDemand/Managing+Your+Files
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4. To compose a new e-mail, click New . 
5. In the From field, enter the sending e-mail address. 
6. Enter the e-mail Subject. 
7. Enter the e-mail body. 

 

Printing a Recipients Report 
You can print a list of your e-mail's recipients. This is helpful to keep for your records. 

If your e-mails stop sending, you can print this list and find the last person the e-mail was sent to. Then, 

correct that e-mail address, edit your search results to remove those who the e-mail was sent to, and 

resend the e-mail to the others. 

1. In the E-mail Editor window, click Recipients . 
2. In the Recipients window, right-click and select Print Grid. 
3. Manage the preferences to your liking, then click File > Print. 

 

Saving E-mails for Future Use 
You can save e-mails that you created for future use. For example, if you send a weekly reminder to staff 

to turn in their time sheets, you can save this e-mail in ACS to speed up the process of sending it each 

week. 

Saving an e-mail saves the from address, subject, text, formatting, merge fields, attachments, and e-mail 

options. However, saving an e-mail does not save the recipients of the e-mail. You must select your 

recipients each time you send the saved e-mail. 

1. After you have selected your recipients and composed the email, click Save . 
2. Enter a name for the e-mail. 
3. Click Save. 

1. After you have selected your e-mail recipients, click Open . 
2. Select the e-mail. 
3. Click OK. Now you can edit the e-mail, save it again, or send it. 

1. Next to Searches and Reports, click Searches. 
2. In the right pane, click Mass E-mail. 
3. Under E-mail Method, select Use Local SMTP and click OK. 

4. Click Open . 
5. Select the e-mail and click Delete. 
6. When the confirmation message displays, click Yes. 
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Using the E-mail Spellcheck and Thesaurus 
In the ACS E-mail Editor, you can correct misspelled words individually or in mass and look up synonyms 

and antonyms. 

You can customize the spellcheck to correct automatically as you type, to ignore abbreviations, 

uppercase words, and web addresses, and to correct dual capitalization and double-words. You can add 

custom dictionaries to add new words, exclude certain words, and automatically replace specific words 

with others. 

  

Checking Spelling in E-mails 
After you have selected your recipients and composed your e-mail, you can check spelling. To spellcheck 

only a particular section of text, highlight that text before clicking Spellcheck  
To ignore the replacement term and suggestions, click Ignore. 
To replace the misspelled word with the word in the Replace With field, click Change. 
To replace all occurrences of the misspelled word with the word in the Replace With field, click Change 

All. To add the misspelled word to the Spellcheck dictionary (so that it is no longer considered a 

misspelling), click Add. 
To replace the misspelled word with the first word in the Suggestions list, click Auto-Correct. 

Enter the word you want to replace the misspelled word and click Change or Change All. 
3.  Click OK when the spellcheck is complete.  

1 .   

2 .   

. 

Click    . The Spellcheck reviews the first occurrence of a misspelled word and offers  Spellcheck 
replacement terms and suggestions. 
For each word, do one of the following: 

Tip 

If the Spellcheck doesn't detect any misspellings, "Spellcheck is complete" displays. 
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Custom Dictionaries 
You can create a custom dictionary so that misspellings — and pet-peeves — are corrected to your 

preference. For example, if you want all occurrences of "irregardless" replaced with "regardless," you can 

set these words as an auto-correct pair in your custom dictionary. 

You can also edit dictionaries, including the default dictionary included with ACS, to match your word 

preferences. 

1. Next to Searches and Reports, click Searches. 
2. In the right pane, click Mass E-mail. 
3. Under E-mail Method, select Use Local SMTP. 
4. Click OK. The E-mail Editor opens. 

5. Click Spellcheck Setup . 
6. Click Dictionaries, then click New, then enter a name for the new custom dictionary. 
7. Click OK. Now you can manage the words in the dictionary. 

1. Next to Searches and Reports, click Searches. 
2. In the right pane, click Mass E-mail. 
3. Under E-mail Method, select Use Local SMTP. 
4. Click OK. The E-mail Editor opens. 

5. Click Spellcheck Setup . 
6. Click Dictionaries. 
7. Select the dictionary and click Edit. Now you can manage the words in the dictionary. 

1. Next to Searches and Reports, click Searches. 
2. In the right pane, click Mass E-mail. 
3. Under E-mail Method, select Use Local SMTP. 
4. Click OK. The E-mail Editor opens. 

5. Click Spellcheck Setup . 
6. Click Dictionaries. 
7. Select the dictionary and click Delete. 
8. When the confirmation message displays, click Yes. 

Managing the Words in Custom Dictionaries 
A custom dictionary allows you to customize the spellcheck process. You can add words so that they are 

always considered correct. You can exclude words so that they are always considered incorrect. You can 

also add auto-correct pairs so that each occurrence of a particular word is always replaced with another 

word. 
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1. In the E-mail Editor window, click . 
2. Click Dictionaries, then select the dictionary and click Edit. 
3. On the Added Words tab, enter the word. 
4. Click Add, then OK. 

1. In the E-mail Editor window, click . 
2. Click Dictionaries. 
3. Select the dictionary and click Edit. 
4. On the Excluded Words tab, enter the word. 
5. Click Add, then click OK. 

1. In the E-mail Editor window, click . 
2. Click Dictionaries. 
3. Select the dictionary and click Edit. 
4. On the Auto-Correct Pairs tab, in the Replace field, enter the word that you want replaced. For 

example, irregardless. 
5. In the With field, enter the word you want to replace it. For example, regardless. 
6. Click Add, then OK. 
 

Managing Spellcheck and Thesaurus Options 
You can configure your preferences for spelling and grammar changes in ACS. You can also select the 

dictionaries that are referenced for the Spellcheck and Thesaurus. 

1. Next to Searches and Reports, click Searches. 
2. In the right pane, click Mass E-mail. 
3. Under E-mail Method, select Use Local SMTP. 
4. Click OK. The E-mail Editor opens. 

5. Click Spellcheck Setup . 
6. Manage the options to your liking. For detailed help, see Additional Option Information. 
7. Click OK. 

 

Using the E-mail Thesaurus 
Use the e-mail Thesaurus to look up synonyms and antonyms for words in the body of your e-mail. The 

Thesaurus includes a variety of contexts (definitions) for each word. Use the contexts to narrow your 

search for a replacement word. 

1. After you have selected your recipients and composed your e-mail, highlight the word you want to 

look up. 

2. Click Thesaurus . A list of different contexts and suggestions displays. 
3. Do one of the following: 



 

 67 

To see different contexts of the word, in the Contexts list, select a term. 
To look up a word in the Replace With list, select the word and click Lookup. 
To return to the previous list of contexts and suggestions, click Previous. 
To replace the word with one of the suggested terms, select the term and click Replace. 

To leave the word as it is, click Cancel. 
 

Quick View 
ACS People Quick View provides a quick listing and summary information for all of the people in your 

ACS database. It accesses the same data as ACS. Since ACS Quick View is a smaller program, you can 

use it to look up basic information such as addresses and phone numbers more quickly. You can look up 

a person's address, phone numbers, e-mail address, and pictures. 

ACS Organizations Quick View is a tool you can use to quickly look up information about your 

organizations and their staff members. ACS Quick View provides a list of any positions the staff member 

has held along with his or her primary affiliation. You can also get directions to a person's address or 

copy their name and address to the clipboard for use in other programs. 

You can use ACS Quick View on a computer that has the single PC version of ACS installed, or on a 

network that has the network version of ACS installed. You can also use Quick View while ACS is 

running. 

Customizing Quick View 
You can customize many areas in ACS Quick View. 

With the appropriate security rights, you can add fields, date fields, and lists to the Personal Information 

area and set the default e-mail tab. 

Granting Quick View Setup Access 
By default, users are not allowed to customize ACS Quick View. You can grant access to ACS Quick 

View Setup in the Add/Edit Users section of the ACS People Suite. If a user does not have access to 

ACS Quick View Setup, the Setup option does not display on the File menu. 

  

1. Log in to the ACS People Suite. 
2. On the Utilities menu, click Add/Edit Users. 
3. Select the user to whom you want to grant access, and click Edit. 
4. On the Security tab, expand the People module. 
5. Double-click Quick View Setup to change the rights from None to All. 
6. Click OK. 
 

Requiring User Login in Quick View 
By default, users are not required to log in to ACS Quick View. You can choose to require users to log in. 

If you require users to log in, users will only see data that the user has rights to see. 

1. On the File menu, click Login. 
2. Enter your user name and password, then click OK. 
3. On the File menu, click Setup. If Setup is not available, you might not have the appropriate rights to 

access Setup. For more information, see Granting Quick View Setup Access. 

https://wiki.acstechnologies.com/display/ACSDOC/Setting+People+Suite+Security+Rights
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4. Select Require Login. 
5. Click OK. 

1. On the File menu, click Setup. If Setup is not available, you might not have the appropriate rights to 

access Setup. For more information, see Granting Quick View Setup Access. 
2. Clear the Require Login check box. 
3. Click OK. 
 

Adding and Removing Custom Quick View Fields 
You can customize many areas in ACS Quick View by adding fields, date fields, and lists to the Personal 

Information area as well as setting the default email tab. 

You can also add up to 10 custom fields to the Personal Information area. These fields can be either 

standard fields or additional fields defined by your organization. 

Tip 

If you use People and Organizations, the tab that contains the People information is named Staff by 

default. You can rename this tab and title it People in the Tab Caption field under People Settings. 

1.  On the File menu, click Setup. If Setup is not available, you might not have the appropriate rights to 

access Setup. For more information, see Granting Quick View Setup Access 

 2.  Under Field Settings, select the fields you want to add from the available Field lists. 
3.  Click OK. 

1. On the File menu, click Setup. If Setup is not available, you might not have the appropriate rights to 

access Setup. For more information, see Granting Quick View Setup Access. 
2. Under Field Settings select the fields you want to remove and press the Delete key. 
3. Click OK. 

 

Setting the Default Quick View E-Mail Type 
By default, ACS Quick View displays the first email address listed for a person. You can select a specific 

default email type. If that type of email address exists for a person, it displays. Otherwise, the individual's 

preferred email address displays. 

1. On the File menu, click Setup. If Setup is not available, you might not have the appropriate rights to 

access Setup. For more information, see Granting Quick View Setup Access. 
2. Under General Settings, select the Default E-mail Type. 
3. Click OK.  
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People Quick View 
ACS Quick View is a tool you can use to quickly access information about the people in your database. It 

accesses the same data as ACS software. Since ACS People Quick View is a smaller program, you can 

save time by using it to look up basic information such as addresses and phone numbers. 

ACS Quick View can be used on a computer with the ACS desktop software installed or on a network 

with the ACS network software installed. 

With ACS Quick View, you can access a person's address, phone numbers, email address, and pictures. 

The program provides a list of any small groups or Sunday School classes the person belongs to. You 

can also get directions to a person's address, or copy their name and address to the clipboard for use in 

other programs. 

Personal information can also be customized by adding additional fields, date fields, and lists to the 

Personal Information area. 

Ready to get started? Just click on a link below to learn more about ACS Quick View. 

Working with Individual Records in People Quick View 
ACS People Quick View provides a quick listing and summary information for all of the people in your 

ACS database. 

You can look up a person's address, phone numbers, email address, and pictures. ACS People Quick 

View provides a list of small groups or Sunday School classes the person belongs to. You can get 

directions to a person's address, or copy their name and address to the clipboard for use in other 

programs. 

You can also customize personal information by adding additional fields, date fields, and lists to the 

Personal Information area. 

 

Searching, Sorting, and Grouping People in People Quick View 
By default, all of the records in ACS software display in the Name list. You can search for specific people 

by name, address, or phone number. When searching for people, you can enter a full or partial name, 

address, or phone number. 

By default, people are sorted alphabetically by last name. You can also group them by family or sort them 

by first name. 

1. In the Last Name, First Name field, enter all or a portion of the person's last name. You can also use 

a comma and type the first few letters of the first name. For example, enter the letters "gai,m" (without 

quotes) to search for Michele Gainey. 
2. Press Enter. The people whose names meet the criteria are listed in the Names list. 

1. In the Address field, enter all or part of the address you want to search for. 
2. Press Enter. The people whose names meet the criteria are listed in the Names list. 

1. In the Phone field, enter all or part of the phone number you want to search for. 
2. Press Enter. The people whose names meet the criteria are listed in the Names list. 
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1. Right-click in the Names list. 
2. Click Sort by Last Name. 

1. Right-click in the Names list. 
2. Click Sort by First Name. 

1. Right-click in the Names list. 
2. Click Sort by Family. 

 

Copying Information in People Quick View 
You can copy a person's name and address to the Windows clipboard for use in other programs. You can 

choose between the family and individual names, as well as the formal and informal names. 

1. Select the person whose name and address you want to copy to the Windows clipboard. 

2. Click the Copy to Clipboard  button. 
3. Click the desired name and address combination. The name and address are copied on to the 

Windows clipboard and can be pasted into any Windows program that supports pasting from the 

clipboard, such as Microsoft Word. 
 

Getting Directions in People Quick View 
With ACS People Quick View and an Internet connection, you can quickly get directions to a person's 

home or office address. Directions are given from your organization's address as entered in the ACS 

software under Site Information Setup. If your organization's address is not in the ACS software, ACS 

People Quick View provides a map of the general vicinity of the person's address instead of detailed 

directions. 

1. Select the person to whose address you want directions. 
2. If more than one address exists for the person, select the address to which you want directions by 

clicking the address tabs. 
3. Click the address. Your browser opens with directions to the person's address. 

  

 Viewing Pictures in People Quick View 
Pictures are helpful for associating a name with a face, especially in large organizations. If you have a 

person's individual or family picture in the ACS software, you can view it with ACS People Quick View. 

1. Select the person whose picture you want to view. 

2. Click the View Picture  button.  
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Organizations Quick View 
ACS Organizations Quick View provides a quick listing and summary information for all of your 

organizations and staff members. 

You can look up an organization's Address, phone numbers, email address, website, PIN, Parent, and 

staff members. Staff members can be filtered by date, showing only the staff members active on the 

selected date. 

You can also get directions to an organization or copy the organization's name and address to the 

clipboard for use in other programs. You can even view the organization's picture, if the organization has 

a picture uploaded in ACS. 

Organization information can also be customized by adding additional fields, date fields, lists, and 

statistics to the Organizations tab. 

  

Changing Display Names and Sort Order in Organizations Quick 

View 
By default, organizations are displayed and sorted alphabetically by name. Since many organizations 

have the same name, you can also display the organization's primary address or meeting address with 

the organization's name, or you can display the organizations by reference name. 

1. Click the Organizations tab. 
2. Right-click in the names list. 
3. Click the display you want and sort properties. 

 

Copying Information in Organizations Quick View 
You can copy the organization's name and address to the Windows clipboard for use in other programs. 

1. Click the Organizations tab. 
2. Select the organization whose name and address you want to copy to the Windows clipboard. 

3. Click the Copy to Clipboard  button. 
4. Click the desired name and address combination. The name and address are copied on to the 

Windows clipboard and can be pasted into any Windows program that supports pasting from the 

clipboard, such as Microsoft Word. 
 

Getting Directions in Organizations Quick View 
With ACS Quick View and an Internet connection, you can quickly get directions to an organization's 

office. Directions are from your organization's address as entered in ACS under Site Information Setup. If 

your organization's address is not in ACS, ACS Quick View provides a map of the general vicinity of the 

organization's address instead of directions. 

1. Click the Organizations tab. 
2. Select the organization to which you want directions. 
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3. If more than one address exists for the organization, select the address to which you want directions 

by clicking the address tabs. 
4. Click the address. Your browser opens with directions to the organization's address. 
 

Searching for Organizations in Quick View 
By default, all organizations are listed in the Name list. You can search for specific organizations or filter 

the list by name, address, city, PIN, or level. 

When searching by name, address, or city, you can enter the full name, address, city, or PIN, or a partial 

name, address, city, or PIN. 

1. Click the Organizations tab. 
2. In the Name field, enter all or a portion of the organization's name or reference name. 
3. Press Enter. The organizations whose names or reference names meet the criteria are listed in the 

Names list. 

1. Click the Organizations tab. 
2. In the Address/City field, enter all or a portion of the organization's street address, PO box, or city. 
3. Press Enter. The organizations whose address or city meet the criteria are listed in the Names list. 

1. Click the Organizations tab. 
2. In the PIN field, enter all or a portion of the organization's PIN. 
3. Press Enter. The organizations whose PIN meets the criteria are listed in the Names list. 

1. Click the Organizations tab. 
2. In the Level list, select the level by which you want to filter the list. 
 

Viewing Pictures in Organizations Quick View 
If an organization has a picture uploaded in ACS, you can view the picture in ACS Quick View. 

1. Click the Organizations tab. 
2. Select the organization whose picture you want to view. 

3. Click View Picture .  
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Mail Merge 
With ACS Mail Merge, you can create letters, mailing labels, and envelopes for a group of individuals or 

for a single individual in your database. You can merge to an existing document or you can create a new 

one. 

You can insert data fields from the People, Contributions, and Organizations fields into your 

document. 

Mail Merge Fields 
Once your document is open, you can insert mail merge fields based on the options you chose in setup. 
 

Mail Merge Setup 
After you select the recipients for your mail merge, you will need to select your setup options. You will 

then create a new document, load an existing document previously created, or edit a document that has 

already been loaded into the Mail Merge window. 

1. In the Mail Merge window, click Mail Merge Setup. 
2. Select the options you want on the Name Settings, Special Fields, Contributions, and Merge 

Options tabs. 
3. Click Process. 
4. Click Close. 

 

Processing a Mail Merge Document 
When processing a mail merge, you can load a document that has been previously created, edit a 

document that has already been loaded into mail merge, or create a new document. 
 

Creating a New Document 
When you create a new document for mail merge, select your recipients and select your options in Mail 

Merge Setup first. 

1. In the Mail Merge window, click Mail Merge Setup. 
2. Select the options you want on the Name Settings, Special Fields, Contributions, and Merge 

Options tabs. 
3. Click Process, then click Close. 
4. In the Mail Merge window, click Create New Main Document. 

 

Editing a Document 
If you have previously loaded a document that you want to use for your mail merge, select your 

recipients, select your mail merge setup options, then edit the document. 

1. In the Mail Merge window, click Load Document. 
2. Select the document you want to edit, then click Mail Merge Setup. 
3. Select the options you want on the Name Settings, Special Fields, Contributions, and Merge 

Options tabs. 
4. Click Process, then click Close. 

https://wiki.acstechnologies.com/display/ACSDOC/People
https://wiki.acstechnologies.com/display/ACSDOC/Contributions
https://wiki.acstechnologies.com/display/ACSDOC/Organizations
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5. In the Mail Merge window, highlight the document you loaded, then click View/Edit Main Document. 
 

Loading a Document 
After selecting your mail merge recipients, you can load a previously created document to process. 

Select your options in Mail Merge Setup then edit the document. 

1. In the Mail Merge window, click Load Document. 
2. Select the document you want from your hard drive. 
3. Click OK. 
4. In the Mail Merge window, highlight the document you loaded, then click Mail Merge Setup. 
5. Select the options you want on the Name Settings, Special Fields, Contributions, and Merge 

Options tabs. 
6. Click Process, then click Close. 
7. In the Mail Merge window, highlight the document you loaded, then click View/Edit Main Document. 

 

Selecting Mail Merge Recipients 
You can process a mail merge for a group of individuals or for just one person. 

If you are processing a mail merge for a group, you will select these individuals through Searches. You 

can use the Edit Results option in Searches to select the individuals you want if they do not have search 

criteria in common. If you are processing a mail merge for just one individual, you will select this 

individual through the Find Person window. 

1. Under Manage Records, select the People tab. 

2. In the drop-down list, select View/Edit Individual and click Go . 
3. Select the individual you want to process a mail merge for, and click View/Edit. 

4. On the Profile tab, click Send Letter . 

1. Under Searches and Reports, click Searches. 
2. Select your search criteria and process the search, or load a previously saved search. If necessary, 

you can edit your search results to remove or add individuals. 
3. On the Search Information tab, click Mail Merge. 

 

ACS Multi-Site 
With ACS Multi-Site, you can track giving across campuses and create departmental fields for the 

individuals in your church or organization. 
  

https://wiki.acstechnologies.com/display/ACSDOC/Editing%2C+Saving%2C+and+Loading+Search+Results
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Departmental Fields 
 

Note 

Departmental Fields are available if you are an Organizations client or if you purchase the ACS 

Multi-Site module. The ACS Multi-Site module is available to clients enrolled in the MegaChurch 

Client Program for free, and is available to all other clients for purchase. 

On the Departmental Fields tab on individual records, you can track customized fields for the 

departments within your church or organization. You can define the fields you want to track for the 

individuals in the department, using up to 22 data fields. The Departmental Fields tab works similarly to 

the Additional Fields tab in the way that you add new fields. 

For example, if your church or organization has a disaster relief team, you could set up a page with the 

following departmental fields: 

• The team members' disaster relief skills 

• Years of experience 

• Pay rate 

This will add the new departmental fields to all individual records. You could then add the information for 

each member on the Departmental Fields tab on their individual records. 

Security for Departmental Fields is controlled in Add/Edit Users. To see the Departmental Fields tab, you 

must have security access for Departmental Fields. Limiting access to Departmental Fields is helpful if 

you use them to track classified information, such as recovery programs within your church or 

organization. 

 

Setting up User Rights for Departmental Fields 
You can grant access to view, edit, and set up departmental fields. You can also limit which departmental 

fields users have access to. 

1. Under Advanced Tools, click the Admin Utilities tab. 

2. In the drop-down list, select Add/Edit Users, then click Go . 
3. Select a user in the grid and click Edit. 
4. Click the Security tab. 
5. Expand People. 
6. To grant access to view departmental fields, right-click View/Edit Department Fields and select 

View. To grant access to view and edit departmental fields, select All. To prevent a user from editing 
or viewing departmental fields, select None. 

7. To grant access to set up departmental fields, right-click Setup Departmental Fields and select All. 
To prevent a user from setting up departmental fields, select None. 

8. Click Apply, then OK. 

1. Under Advanced Tools, click the Admin Utilities tab. 

https://wiki.acstechnologies.com/display/ACSDOC/The+Additional+Fields+Tab+-+Tracking+Additional+Information
https://wiki.acstechnologies.com/display/ACSDOC/The+Additional+Fields+Tab+-+Tracking+Additional+Information


 

 76 

2. In the drop-down list, select Add/Edit Users, then click Go . 
3. Select a user in the grid and click Edit. 
4. Click the Information tab. 
5. Select Limit Departmental Fields, then click Select. 
6. Select the departmental fields you want the user to have access to. Click OK. 
7. Click Apply, then OK. 
 

Setting up the Departmental Fields Tab 
The first step of using Departmental Fields is setting up each department. You will then set up the fields 

that will display on all individual records. Seven field types are offered for customizing each department's 

fields. 

Once the fields are set up, you can enter the departmental information for individuals. 

1. Under Manage Records, click the People tab. 

2. In the drop-down list, select View/Edit Individual and click Go . 
3. Select an individual's record and click View/Edit. 
4. On the Departmental Fields tab, click Setup, then click Add to add a new department. 
5. In the Page Description field, enter the department's name and click OK. 
6. Each dotted line represents an available field. Click on one to set up a field. 
7. Under Field Information, enter the name of the field in the Label and Field Name fields. 
8. Under Field Type, select the field type. 
9. Under Field Display Settings, select Header if you want to use the field as a header for other fields 

or select Show Description as Bold to bold the Field Name. 
10. If your Field Type is a list, click Add under List Items to add items to the drop-down list. Enter a 

description and click OK to add the item to the list. Otherwise, go to the next step. 
11. Click OK. 

 

Entering Departmental Fields for an Individual 
Once you've set up your departmental fields, you can enter the corresponding information on an 

individual's profile. 

1. Under Manage Records, click the People tab. 

2. In the drop-down list, select View/Edit Individual and click Go . 
3. Select the individual's record and click View/Edit. 
4. Click on the Departmental Fields tab. 
5. In the Department drop-down list, select the appropriate department. 
6. Enter the individual's information in the fields set up for that department. 
7. To enter information for the next department, click Next Dept. 
8. When finished, click OK to save.  
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Working with Departmental Fields 
You can process searches to view the individuals who meet specific departmental fields criteria. You can 

then export the results to Excel®, send a mass e-mail, or process an Advanced Export. 

1. Under Searches and Reports, click Searches.  
2. On the Search Information tab, select the appropriate options under Search On, Include Records 

That, and Search Output Flag. 
3. Click New Search. 
4. Expand Departmental Fields.  
5. Expand the department you are working with, then double-click the criteria you want to search on.  
6. Select your options, then click OK. 
7. If you are adding other items to the search criteria, make these selections. For example, if you want 

to include the criteria of Member Status. 
8. Click Process. When the confirmation message displays, click OK. 
9. Click the Results tab to view your results. 
 

Working with Mass Change and Departmental Fields 
 

Caution 

Depending on the options you select, you could be changing all records in a filter or search results. 

Confirm the correct records are selected before processing the mass change. Also make sure you 

have a current backup in case a mistake occurs. 

In the Mass Change window, you can edit data in the departmental fields. Mass change has two options:  
changing a field's value or moving the data from one field to another.  

1. If you have not already done so, make a backup. 
2. Under Manage Records, click the Tasks tab. 

3. Select People Mass Change and click Go . 
4. In the Mass Change window, under Change Mode, select Change Field Value. 
5. Under Available Fields, select the field you want to change. 
6. Under Include, select the appropriate option according to which records you want to change. 
7. Under Move To, enter or select the Value to Change and/or the New Value. 
8. Click Change. 

1. If you have not already done so, make a backup. 
2. Under Manage Records, click the Tasks tab. 

3. Select People Mass Change and click Go . 
4. In the Mass Change window, under Change Mode, select Move Field. 
5. Under Available Fields, select the Individual, Family, or Address field you want to move to a 

departmental field. 
6. Under Move To, select the departmental field you want to move the Individual, Family, or Address 

field to. Only alphanumerical, list, and date fields are available to move into. Individual, organizations, 

currency, and number fields are not available, and the field's description name is not moved. 
7. Click Move. 

https://wiki.acstechnologies.com/display/ACSDOC/Conducting+a+Search
https://wiki.acstechnologies.com/display/ACSDOC/Working+with+Filters+in+ACS+People
https://wiki.acstechnologies.com/display/ACSDOC/Working+with+Search+Results
https://wiki.acstechnologies.com/display/ACSDOC/Performing+a+Manual+Data+Backup
https://wiki.acstechnologies.com/display/ACSDOC/Mass+Changing+Records+in+ACS+People+Suite
https://wiki.acstechnologies.com/display/ACSDOC/Performing+a+Manual+Data+Backup
https://wiki.acstechnologies.com/display/ACSDOC/Performing+a+Manual+Data+Backup
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Campuses in Contributions 

 

When you own the Multi-Site module, you can track gifts and process reports by campus. You can assign 

funds and services to each campus when you set them up in Define Lists. 

Setting up User Rights for Campuses 
You can grant access to set up campuses and services in Define Lists. You can also limit which 

campuses users have access to. When you limit users to certain campuses, they cannot access funds 

assigned to campuses they do not have rights to when running reports, inquiries and searches. Only the 

campuses they have access to will be available in the Campus drop-down list when entering 

contributions. 

2.  In the drop-down list, select Add/Edit Users, then click Go  
3. Select a user in the grid and click Edit. 
4. Click the Security tab. 
5. Expand People. 
6. To grant access to set up campuses and services in Define Lists, right-click Multi-Campus Setup 

and select All. To prevent a user from setting up campuses and services, select None. 
7. Click Apply, then OK. 

1. Under Advanced Tools, click the Admin Utilities tab. 

2. In the drop-down list, select Add/Edit Users, then click Go . 
3. Select a user in the grid and click Edit. 
4. Click the Information tab. 
5. Select Limit Campuses, then click Select. 
6. Select the campuses you want the user to have access to. Click OK. 
7. Click Apply, then OK. 

  

Note 

Campuses are available when you purchase the ACS Multi-Site module. The ACS Multi-Site  
module is available to clients enrolled in the MegaChurch Client Program for free, and is available  
to all other clients for purchase. 

1 .   Under Advanced Tools, click the   tab. Admin Utilities 

. 

Note 

This option is for setting up the campuses and services in Define Lists only. This does not  
determine whether a user can select campuses when posting contributions. 
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Setting up Campuses in Define Lists 
You can set up your campuses in Define Lists to work with ACS Contributions. For each campus, you 

can assign the service times and funds that each one uses. 

 
4. Click Add. 
5. Enter the service name or time in the Service Description field. 
6. Click OK. 

 
3. Expand Multi-Campus, then select Service. 
4. Select the service you want to change, then click Edit. 
5. Make the necessary changes, then click OK. 

1. Under Advanced Tools, click the Define Lists tab. 

2. In the drop-down list, select People, then click Go . 
3. Expand Multi-Campus, then select Campus. 
4. Click Add. 
5. Enter the campus name in the Campus Description field. 
6. Optional: If you have services set up, click the Services tab, then click Select to assign services to 

the campus. 
7. Optional: Click the Funds tab, then click Select to assign funds to the campus. 
8. Click OK. 

 
4. Select the campus you want to change, then click Edit. 
5. Make the necessary changes, then click OK.  

1 .   

.   2 

.   3 

Under Advanced Tools, click the   tab. Define Lists 

In the drop-down list, select  , then click    . People Go 
Expand  , then select  . Multi-Campus Service 

Funds 

When funds are assigned to a campus, other campuses cannot use those funds. However, when  
entering a batch of contributions where no campus is selected, you can post to any fund including  
those assigned to a campus. 

1 .   

2 .   

Under Advanced Tools, click the   tab. Define Lists 

In the drop-down list, select  , then click    . People Go 

Tip 

To add several services at one time, select the   checkbox. Add Another 

.   1 

.   2 

.   3 

Under Advanced Tools, click the   tab. Define Lists 

In the drop-down list, select  , then click    . People Go 
Expand  , then select  . Multi-Campus Campus 

Tip 

To add several campuses at one time, select the   checkbox. Add Another 

https://wiki.acstechnologies.com/display/ACSDOC/Defining+Lists+in+ACS+People
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Entering and Posting Contributions 
When starting a new batch of contributions, you can select a campus to post to. If services are assigned 

to a campus, only those service times display as options in the Service drop-down list. 

 

 

When entering transactions, the available funds are the ones linked to the selected campus and the 

funds that are not linked to any campus. However, there is an option in Add/Edit Users to Enter All Funds 

regardless of what campus is selected. When a user has access to this, the All Funds checkbox displays 

on the Contributions - Select Fund window. When this option is selected, you can post to all funds 

regardless of the campus selected. 

 

If you do not select a campus, you can post to any fund and any service. 

  

Contribution Reports 
For many of the contributions reports, you can select which campuses to print. For example, you can 

customize the Gift Detail Listing report to print only the gifts posted to the Greenville campus. 

https://wiki.acstechnologies.com/display/ACSDOC/Working+with+Transaction+Batches
https://wiki.acstechnologies.com/display/ACSDOC/Contributions+Reports+and+Statements
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You can also select how to group these reports, by Campus Funds or Campus Batches. 

 

Campus Affiliation for Families and Individuals 
You may want to keep track of which families and individuals are associated with each campus. You can 

do this by creating an additional field in Define Lists for either the Additional Fields tab (individual) on an 

individual's record, or the Family tab, depending on how you want to track this information. 

1. Under Advanced Tools, click the Define Lists tab. 

2. In the drop-down list, select People, then click Go . 
3. Expand Individual or Family, depending on whether you want to track the campus affiliation for 

each family or each individual. 
4. Expand Lists.  
5. Select one of the Not Defined List items. Click Activate Field. 
6. Enter the Field Description, such as "Campus" or "Campus Affiliation."  
7. Click Add. 
8. Enter a campus name in the Field Description. Select Add Another to add several campuses at 

one time. 
9. Click OK.  
10. Once you finish adding all campuses, click Close. The drop-down list of campuses will display on 

either the Additional Fields tab or the Family tab. 

https://wiki.acstechnologies.com/display/ACSDOC/Defining+Lists+in+ACS+People

